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1 Introduction

1.1 Analog Devices FreeRTOS

The Analog Devices FreeRTOS product is an add-on to the FreeRTOS Real -time operating system
that provides additional support for Analog Devices processors. The product isinstalled on top of the
FreeRTOS operating system in order to gain additional platform support.

In order to avoid confusion the FreeRTOS operating system will be referred to asthe FreeRTOS
product. Components from Analog Devices are dways referred to as the Analog Devices FreeRTOS
product or the FreeRTOS product from Analog Devices.

The Analog Devices FreeRTOS product contains ports of FreeRTOS specific to Analog Devices
processors and FreeRTOS exampl e applications for Analog Devices processors. It isintended to be
installed on top of version 10.0.x of the FreeRTOS operating system.

1.2 What's in the user's guide
This User's Guide document provides instructions on getting started with FreeRTOS for these boards
using the following development environments:

® CrossCore Embedded Studio

* |AR Embedded Workbench

e Kell MDK5

The following processors are supported with examples being provided for the following EZ-Kits:

Processor s Supported Examples Provided For

ADSP-SC5xx Cortex-A5 Core ADSP-SC589 EZ-Kit
ADSP-SC584 EZ-Kit
ADSP-SC573 EZ-Kit

ADSP-SC5xx SHARC+ Core ADSP-SC589 EZ-Kit
ADSP-SC584 EZ-Kit
ADSP-SC573 EZ-Kit

ADSP-BF7xx ADSP-BF707 EZ-Kit

ADuCM302x ADuUCM3029 EZ-Kit

FreeRTOS User's Guide 7



Processor s Supported Examples Provided For
ADUCM405x ADUCM4050 EZ-Kit
ADSP-2156x ADSP-21569 EZ-Kit
Detailed description for setting up the hardware and software environment, and how to run the demo

exmaples on Analog Devices processor boards are included. An appendix containing RTOS
benchmark data for various platformsis aso provided.
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2 Hardware and software set up

To run the FreeRTOS examples, this section would guide users how to get the hardware and software
ready, including get the FreeRTOS source code and set up running environment.

2.1 Get the hardware ready

The Analog Devices FreeRTOS product supports a couple of reference development board from
Analog Devices, including ADuCM 3029/4050 EZ-Kit board, ADSP-SC589/A DSP-SC584/ADSP-
SC573 EZ-Kit board, BF707 EZ-Kit board and ADSP-21569 EZ-Kit board. Depending on which
software development tool you are using, different JTAG debug board are required.

Below isalist of the hardware involved.
ADI reference board:

* ADuCM3029 EZ-kit: http://www.ana og.com/en/desi gn-center/eval uation-hardware-and-
software/eval uation-boards-kits/eval -aducm3029-ezkit.htmL

* ADuUCMA4050 EZ-kit: http://www.anal og.com/en/desi gn-center/eval uation-hardware-and-
software/eval uation-boards-kitsy ADZS-U4050L F-EZKIT.html

* ADSP-SC589 EZ-kit: http://www.anal og.com/en/desi gn-center/eval uation-hardware-and-
software/eval uation-boards-kits/EV AL-ADSP-SC589.html

* ADSP-SC584 EZ-kit: http://www.anal og.com/en/design-center/eval uation-hardware-and-
software/eval uation-boards-kits/EV AL-ADSP-SC584.html

® ADSP-SC573 EZ-kit: http://www.anal og.com/en/desi gn-center/eval uation-hardware-and-
software/eval uation-boards-kits/ SC573EZKIT.html

* ADSP-BF707 EZ-kit: http://www.anal og.com/en/desi gn-center/eval uation-hardware-and-
software/eval uation-boards-kits/eval -bf 707.html

* ADSP-21569 EZ-kit: https://www.anal og.com/en/desi gn-center/eval uation-hardware-and-
software/eval uation-boards-kitsyADZS-21569-EZKI T .html

Jag debugger:

* |CE1000/2000: http://www.anal og.com/en/design-center/eval uation-hardware-and-software
/evaluation-boards-kits'emulators.html

® JLink: https:.//www.segger.com/products/debug-probes/j-link/model §/j-link-lite/j-link-lite-arm/
PC:

A mainstream configuration of Windows PC isrequired. Verify that your PC has these minimum
requirements:
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2 GHz single core processor; 3.3GHz dual core or better recommended
4 GB RAM; 8GB or more recommended
2 GB available disk space

® One open USB port

2.2 Get the source code ready

This page describes how to get the FreeRTOS source code.

2.2.1 Download FreeRTOS source code

Source code for both upstream official FreeRTOS release, and the Analog Devices FreeRTOS add on
product release are required. As shown in the list:

Name Version Download from

Official FreeRTOS 10.0.0 https://sourceforge.net/projects/freertos/files/FreeRTOS/

source code
Anaog Devices 1.4.0 http://www.anal og.com/en/desi gn-center/processors-and-dsp/eval uation-and-
FreeRTOS devel opment-software/freertos.html#dsp-rel atedsoftware

2.2.2 Install the FreeRTOS product from Analog Devices

To install the Analog Devices FreeRTOS product you will need to first unzip the FreeRTOS product
and then install the Analog Devices FreeRTOS product on top of it:

For example, unzip them into folder "freertos’:

1. Unzip the "FreeRTOSv10.0.0.zip" into C:\Analog Devices\freertos.

Y ou will get the path such as "C:\Anaog Devices\freertos\FreeRTOSv10.0.0\FreeRTOS".
2. Unzip "adi-freertos-1.4.0.zip" into C:\Analog Devices\freertos.

It will add new files and overwrite some files saved in "C:\Analog Devices\freertos\FreeRTOSv10.0.0
\FreeRTOS".
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2.3 Software environment set up for CrossCore Embedded Studio

This part shows the software environment setup for CrossCore Embedded Studio on four kinds of
boards: ADSP-SC589/ADSP-SC584/ADSP-SC573/ADSP-2156X, ADuCM 3029 EZ-Kit,
ADuCM4050 EZ-Kit AND ADSP-BF7XX EZ-Kit.

ADSP-SC589/ADSP-SC584/ADSP-SC573
* Anaog Devices CrossCore Embedded Studio version 2.8.3 or later

® For Userswant to try LwIP, install LwIP for CCES: Lightweight TCP/IP Stack for CrossCore
Embedded Studio Rev. 2.6.0 (http://www.anal og.com/en/desi gn-center/processors-and-dsp
/evaluation-and-devel opment-software/adswp-Iwip.html#dsp-rel atedsoftware)

ADuUCM3029 EZ-K it
* Analog Devices CrossCore Embedded Studio version 2.8.3 or later

® Device Family Pack (DFP) for CCES: ADuCM302x Software for Keil version 1.0.6 or later (

http://www.anal og.com/en/desi gn-center/eval uation-hardware-and-software/eval uation-boards-
kits/eval-aducm3029-ezkit.html#eb-rel atedsoftware)

ADuCM4050 EZ-K it
® Analog Devices CrossCore Embedded Studio version 2.8.3 or later

* Device Family Pack (DFP) for CCES: ADuCM4x50 Device Family Pack version 3.1.0 or later (
http://www.anal og.com/en/desi gn-center/eval uation-hardware-and-sof tware/eval uation-boards-
Kits/ADZS-U4050L F-EZKIT.html#eb-rel atedsoftware )

ADSP-BF7XX EZ-Kit

* Anaog Devices CrossCore Embedded Studio version 2.8.3 or later
No other software needed to run the examplesin CCES on ADSP-BF707 board.

ADSP-2156X EZ-Kit

® Analog Devices CrossCore Embedded Studio version 2.9.1 or later
No other software needed to run the examplesin CCES on ADSP-2156X board.

2.4 Software environment set up for IAR Embedded Workbench

This part shows the software environment setup for IAR Embedded Workbench on two kinds of
boards: ADUCM 3029 EZ-Kit and ADUCM4050 EZ-Kit. For ADSP-SC589/SC584/SC573 EZ-Kit
boards, users do not need to install any other pack files except the software IAR Embedded
Workbench version 7.60 or later.

ADuCM3029 EZ-K it
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* |AR Embedded Workbench version 7.60 or later

® Board Support Package (BSP) for IAR: ADUCM302x EZ-Kit Lite BSP for IAR version 1.0.6 (
http://www.anal og.com/en/desi gn-center/eval uation-hardware-and-software/eval uation-boards-
kits/eval-aducm3029-ezkit.html#eb-rel atedsoftware )

® Edit an environment variable for your account ( ADI_CM302x_BSP_PATH: This should
point to the ADUCM302x_EZ_Kit/ directory of your ADUCM302x BSP installation)

ADuCM4050 EZ-K it
* |AR Embedded Workbench version 7.60 or later

* ADuCM4050 EZ-Kit: ADUCM4x50 BSP for IAR version 1.1.0 (http://www.anal og.com/en
/design-center/eval uation-hardware-and-software/eval uation-boards-kitsy ADZS-U4050L F-
EZKIT.html#eb-rel atedsoftware)

* Edit an environment variable for your account ( ADI_CM4x50 BSP_PATH: This should
point to the ADUCM4x50 EZ Kit/ directory of your ADUCM4x50 BSP installation)

2.5 Software environment set up for Keil MDK

This part shows the software environment setup for Keil MDK on two kinds of boards: ADuCM 3029
EZ-Kit and ADuCM4050 EZ-Kit. For ADSP-SC589/SC584/SC573 EZ-Kit boards, users do not need
toinstall any other pack files except the software Keil MDK for ARM processors version 5.21a or
later.

ADuUCM 3029 EZ-Kit
* Keil MDK for ARM processors version 5.21aor later

® Device Family Pack (DFP) for Keil: ADUCM3029 EZ-Kit: ADUCM 302x Software for Keil

version 1.0.6 (http://www.anal og.com/en/desi gn-center/eval uation-hardware-and-software
/eval uation-boards-kits/eval -aducm3029-ezkit.html#eb-rel atedsof tware)

® Board Support Package (BSP) for Kell: ADUCM302x EZ-Kit Lite BSP for IAR version 1.0.6 (

http://www.anal og.com/en/desi gn-center/eval uation-hardware-and-software/eval uation-boards-
kits/eval-aducm3029-ezkit.html#eb-documentation )

® Edit an environment variable for your account ( ADI_CM302x_BSP_PATH: This should point
to the ADUCM302x_EZ_Kit/ directory of your ADUCM302x BSP installation)

ADuCM4050 EZ-Kit
* Kell MDK for ARM processors version 5.21aor later

* Device Family Pack (DFP) for Keil: ADuCM4x50 Device Family Pack version 3.1.0 (_
http://www.anal og.com/en/desi gn-center/eval uation-hardware-and-sof tware/eval uation-boards-
Kits/ADZS-U4050L F-EZKIT.html#eb-rel atedsoftware )
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* Board Support Package (BSP) for Keil: ADUCM4x50 EZ-KIT Board Support Pack version
3.1.0 (http://www.anal og.com/en/desi gn-center/eval uation-hardware-and-software/eval uation-
boards-kitsADZS-U4050L F-EZKIT.html#eb-rel atedsoftware)

® Edit an environment variable for your account ( ADI_CM4x50 BSP_PATH: This should point
to the ADUCM4x50_EZ_Kit/ directory of your ADUCM4x50 BSP installation)

FreeRTOS User's Guide
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3 Running the Examples on the ADuCM302x EZ-Kit

The FreeRTOS product for Analog Devices processors contains the following examples:

Processor Toolchain Example(s)

ADuUCM3029 |AR Embedded Workbench Basic Demo
ADuUCM3029 Keil MDK Basic Demo
ADUCM3029 CrossCore Embedded Studio Basic Demo

The basic demo example is based on the Standard Demo Tasks that FreeRTOS recommend are
provided for each port of the FreeRTOS Operating System.

For more information on the Standard Demo Tasks please refer to http://www.freertos.org/a00013.
html.

The tasks performed in the Analog Devices Basic Demo include:
* LED flash
* Polled queue tasks
* Recursive Mutex tasks
* Blocking Queue tasks
e Statically allocated tasks
® Suicidal tasks

3.1 Running the Basic Example for ADuCM302x EZ-Kit with CrossCore
Embedded Studio

3.1.1 Overview

This page describes the steps required to build and run basic example on ADUCM 3029 EZ-KIT board
using CrossCore Embedded Studio.

3.1.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.

FreeRTOS User's Guide 14
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Software Requirement

* Anaog Devices CrossCore Embedded Studio. For more information please refer to Software
environment set up for CrossCore Embedded Studio

® FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADUCM302x EZ-Kit board
* AnICE1000 or ICE2000 emulator

Connect the ICE1000 or ICE2000 emulator to DEBUG P5 port of EZ-Kit and the host PC using USB
cable and simultaneously connect the power supply with 5 volts as in the diagram below

USB TO PC

3.1.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Select the File menu and then select the Import option from the menu and when the Import
project window appears

® Click onthe General folder, then click on the Existing Projectsinto Wor kspace entry, and
click Next
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® Click the Select root directory radio button and then click the Browse button

* Browse the root folder where you previously installed the FreeRTOS product and then browse
down into the FreeRTOSv10.0.0\FreeRTOS\Demo\CORTEX_M3 ADuCM302x_CCES
folder

® A single project should appear in the proj ects pane of the Import window

® Check the entry in the projects pane and click Finish to close the file browser dialog

7 Impart = @
Import Projects e
Select a directory to search for existing Eclipse projects, / ,f“
@ Select rootdirectory:  Ch&nalog Devicestfreertos\FreeRTOS10.0.0 -
Select archive file: Browse..,
Projects:

| BTO5Derno_CCES (Chlnalog DeviceshfreertostFreeRTOS10.0.00F Select All

Dezelect Al
Refresh

Pl 1 3

Options
Search for nested projects
Copy projects into warkspace

Hide projects that already exist in the workspace
Warking sets
Add project to working sets T ey,

Select...

'/?j' < Back Mext » I Finizh ‘ | Cancel

2. Choose Debug/Rel ease mode to build the project.
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Edit Source Refactor Mavigate Search Pro
i tc‘lé'%:_%._ylg %’f'%v[ﬁ_@

roject Explorer 1 Debug Iv = 0|
5 RTOSDemo_¢ Y 2 Release

¥ Binaries

i Includes

iz Debug

iz FreeRTOS

= Include
= Release

1

= Source

= Standard_Demo

= System

B ADuCM3029.1d

El README_RTOSDemo_CCES.txt
% system.svc

3. Build the project in CrossCore Embedded Studio

* IntheProject Explorer right click on the RTOSDemo_CCES project and select the Build
Proj ect option from the menu

3.1.4 Run the Example

Follow below four steps to do debug configuration, download and run the built binary on the target
board.

1. Inthe Project Explorer right click on the RTOSDemo_CCES project and select the Debug As
option from the menu

2. From the popup menu select Debug Configur ations option to create a new debug configuration
that matches your emulator and target board

FreeRTOS User's Guide
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" Debug Configurations (=5
Create, manage, and run configurations @\
Specify and launch an application with GDB and OpenOCD 3
EIEE Name: RTOSDemo_CCES Debug
type filter text [Z] Target . [E Main| %+ Debugger| & Startup| %~ Source| ] Common
I Application with CrossCore Debugger
- . Command:
4 I Application with GDB and OpenOCD (Emu
i@ RTOSDemo_CCES Debug openocd
i Application with GDB and QEMU (Simulat - -
# Launch Group @) Target (pracessor) () Board

|Analog Devices ADUCM3023 -

Interface:
lAnaIDg Devices ICE-1000 Emulator 'J

Max speed:

Halt options
Halt peripherals on suspend

Arguments:

< " 4

Revert J { Apply ‘

Filter matched 5 of 8 items {

'/?) [ Debug I [ Close ‘

3. Click the Debug button to close the Debug Configur ation window
4. Click the Run/Resume button to start running your application

File Edit Source Refactor Navigate Search Project Run Window Help

il | i | w3 s v @ vi®

3.1.5 Test Results

Output from the application should be visible within the Console window in the CrossCore Embedded
Studio IDE. Y ou should see three LEDs on the EZ-Kit are blinking. Thetest isok for <num> round
(s) will be printed constantly and Test Passed which means the test is successful will be printed after
25 rounds in the console.
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& Console 2 ¥ Tasks|[7 Problems| 2 Executables| & Debugger Console| 4" Search
RTOSDemo_CCES Debug [Application with GDB and OpenOCD (Emulator)] RTOSDemo_CCES
The test is ok tor 17 round(s)

The test is ok for 18 round(s)

The test is ok for 19 round(s)

The test is ok for 20 round(s)

The test is ok for 21 round(s)

The test is ok for 22 round(s)

The test is ok for 23 round(s)

The test is ok for 24 round(s)

The test is ok for 25 round(s)

Test passed

3.2 Running the Basic Example for ADuCM302x EZ-Kit with IAR
Embedded Workbench

3.2.1 Overview

This page describes the steps required to build and run basic example on ADUCM 3029 EZ-KIT board
using IAR Embedded Workbench.

3.2.2 Environment Setup

Before running the basic example with IAR Embedded Workbench, you should make some
preparation for environment setup including software and hardware.

Software Requirement

* Anaog Devices AR Embedded Workbench. For more information please refer to Software
environment set up for IAR Embedded Workbench

® FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADuUCM302x EZ-Kit board
® A JLink Lite

Connect DEBUG P4 port of the EZ-KIT board to a PC running IAR Embedded Workbench using the
JLink and simultaneously connect the power supply with 5 volts as in the diagram below
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3.2.3 Build the Example

Before you run the FreeRTOS example in IAR Embedded Workbench, follow below three steps to
import and build it.

1. Select the Add Existing Project from the Project M enu and browse to the FreeRTOSv10.0.0
\FreeRTOS\Demo\CORTEX_M3_ADuCM302x_I AR\iar folder within the FreeRTOS product
directory and import the project

2. Choose Debug/Release mode to build the project.
Eile Edit View Project J)-Link Tools Window Help

== ==y | | -

Workspace * | 1aR tnformation Center for ARM
Cebug hd

Files By
B (FRTOSDemo - Debug v
DFI’EE‘.‘RTOS * R RN RN RR AR
& DI Include

& [ Library
FaEse

& [ Standard_Dema
L@ (7 Output

3. Build the project in the IAR workbench

® From the Project menu select the M ake option and enter the file name
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& 17 - 18R Embedded Workbench IDE - ARM 7.60.1

File Edit ‘“iew Project Jl-Link Tools  Window  Help
~ N = + nop
DS HE| S| R o] Y EmErerARh BUNEL D
Al RS * | 18R Information Center for ARM |
[Dehug V]
o N h Y Y ™ N N
Files & B le . (7 y (7 V7 (5 y (s A le . (7 y (5 Vy
RTOSDem... 9 (sl ® ol [ 31720 [, @ ol (8] [ F=0 | HIE Iz o (21|20 [ AN [ o] "
F®0FreeRTOS RN RARRRRRRRRRRRRRRRARRRRAATY
[Cdinclude
[Library
[dsre
[ Stancard_.
CaCutput
GETTING STARTED USER GUIDES EXAMPLE PROJECTS INTEGRATED
‘Guidelines for setting up Complete product Example applications SOLUTIONS
your project, adding documentation in PDF that demonstrate Information on AR
files, compiling, linking, format gives you all the hardware peripherals for visuslSTATE, RTOS
and debugging it. user and reference specific devices and and middleware
information you nead evaluation boards. solutions.
HARDWARE SUPPORT RELEASE NOTES MY PAGES
SOLUTIONS For questions about how All about the latest Herz you can dawnload
IAR in-circuit debug and to use your |AR product, festures, new device product updates,
trace probes, |AR starter reporting & problem, or support, and program manage licenses and
L finding support comections. contact information, and
resources checkyour SUA status.
| RTO5Demo
x
Messages
BlockO.c
event_groups.c
death.c
heap_4.c
flash.c
main.c
list.c
ParTestc
PollCc
gquEuE.C
port.c
startup.c
recmutex.c
system.c
Staticallocation.c
tasks.c
fimers.c
Linking
Total number of errars: 0
Total number of warnings: 0
-

3.2.4 Run the Example

Follow below two steps to do debug configuration, download and run the built binary on the target

board

1. From the Project menu select the Download and Debug option

2. The application should load and halt at main. Continue the application to see it run.

FreeRTOS User's Guide
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3.2.5 Test Results

Output from the application should be visible within the Terminal 1/0 window which can be found in
View menu in the IAR Embedded Workbench IDE. Y ou should see three LEDs on the EZ-Kit are
blinking. Thetest is ok for <num> round(s) will be printed constantly and Test Passed which

means the test is successful will be printed after 25 rounds in the console.

Terminal IO x

Output: Log file; OFf

The test i= ok for 13 roundis) -
The test i= ok for 14 roundis)
The test i= ok for 15 roundis)
The test iz ok for 16 roundis)
The te=st iz ok for 17 roundis)
The te=t 1=z ok for 18 roundis=)
The te=t 1= ok for 19 roundi=)
The te=st 1= ok for 20 roundis)
The test i= ok for Z1 roundis)
The test i= ok for Z2 roundis)
The test i= ok for 23 roundis)
The test iz ok for 24 roundis)
The te=st iz ok for 25 roundis=)
Test pa=z=ed

3.3 Running the Basic Example for ADuCM302x EZ-Kit with Keil MDK

3.3.1 Overview

This page describes the steps required to build and run basic example on ADUCM 3029 EZ-KIT board
using Keil MDK.

3.3.2 Environment Setup

Before running the basic example with Keil MDK, you should make some preparation for
environment setup including software and hardware.

Software Requirement

* Anaog Devices Keil MDK. For more information please refer to Software environment set up
for Kell MDK

* FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADuUCM302x EZ-Kit board
®* A JLink Lite
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Connect DEBUG P4 port of the EZ-Kit to the host PC using the J-Link connector, connect the USB
to UART port on the EZ-Kit to the host PC using the USB cable provided and simultaneously
connect the power supply with 5 volts asin the diagram below

USB TO PC

3.3.3 Build the Example
Before you run the FreeRTOS example in Keill MDK, follow below four steps to import and build it.
1. Import the FreeRTOS example into Keil MDK

® Select the Open Project option from the Project menu

* Inthefiletree window browse to the FreeRTOSv10.0.0
\FreeRTOS\Demo\CORTEX_M3 ADuCM302x_KEIL folder inthe FreeRTOS product
installation and select the RTOSDemo.uvprojx file.

® Click the Open button to import the project

2. Choose Debug/Rel ease mode to build the project.
File | Edit View Project Flash Debug Peripherals Tools SVCS Window Help
S d @] £ B | | | == | @ sTAc

EANN Ny gQHRelease |V|3§\| dh & D&

3. Build the project in Keil MDK
® Select the Build Target/Rebuild All Target Files option from the Project menu

4. Configure a serial console application of your choice to view the output from the UART to USB
connection on the HOST PC
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= De
File

* TheKeil MDK isunable to output and text to the console within the MDK IDE.The output of

the application is transmitted via UART to the serial console. The easiest way to determine the
correct USB deviceisto view the Ports entry in the Windows Device Manager.From here

identify the COM port.Configure your serial console application to connect to the port with a
baud rate of 57600

wice hanager

Action

Wiew  Help

e | = HME &

1M Computer

b Disk drives
b B Display adapters

-':!:J Hurnan Interface Devices

b g IDE ATAJATAPT controllers
.. Keyboards
b P Mice and other pointing devices
l- Manitors

¥ Metwark adapters

-5 Cther devices

b8 System devices

TS Ports (COM &L LPT)
JE Communications Port (COM1)
TS USE Serial Port (COMT)
D Processors

» - i Universal Serial Bus controllers

-8y Sound, video and game controllers

3.3.4 Run the Example

m

ﬁ PuTTY Configuration

Category:

—|- Session

: Logging

= Terminal

- Keyboard
- Bell

- Features

= "window

- Appearance
- Behaviour
- Tranhglation
- Selection
- Calours

= Connection

- Data

- Prosy

- Telnet

- Rlogin

+- 55H

B asic options for your PuT T session

Specify the destination you want to connect to

Sernial line
COmM7
Connection type:
Raw Telnet

Rlogin

S5H

Load, save or delete a stored session

Saved Sessions

@ Serial

Default Setings

Cloze window on exit
Always Mever

@ Only on clean exit

Load
Save
Delete

Open | | Cancel

Follow below two steps to do debug configuration, download and run the built binary on the target

boar

d

1. From the Flash menu select the Download sub-menu and then choose the Start/Stop Debug
Session option from Debug menu.

2. Click the Run button to start running the application

File Edit View Project Flash
& d8]% 0

%§| = e3| 2 =;|

Registers

Reqister |VaMe |

=l Core
RO (00000000
A1 (00000000
R2 (00000000
R3 (00000000
R4 (00000000
R& 000000000
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Peripherals

Tools

SVC

HeEEE 2

o @ Disassembly

=0x00000ZED
0x00000ZE2
Ox00000ZE4
Ox00000ZE#
0x000002ES
Ox00000ZEL
0x00000ZEC
0x00000ZEE

4509
4750
4509
4700
EVFE
EVFE
E7FE
ETFE
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3.3.5 Test Results

When the application runsit will blink three LEDs on the EZ-Kit, Thetest isok for <num> round(s)
will be printed constantly and Test Passed which means the test is successful will be printed after 25
rounds on the console.
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4 Running the Examples on the ADuCM4x50 EZ-Kit

The FreeRTOS product for Analog Devices processors contains the following examples:

Processor Toolchain Example(s)

ADuUCM4050 CrossCore Embedded Studio Basic Demo
ADuUCM4050 |AR Embedded Workbench Basic Demo

ADUCM4050 Keil MDK Basic Demo

The basic demo example is based on the Standard Demo Tasks that FreeRTOS recommend are
provided for each port of the FreeRTOS Operating System.

For more information on the Standard Demo Tasks please refer to http://www.freertos.org/a00013.
html.

The tasks performed in the Analog Devices Basic Demo include:
* LED flash
* Polled queue tasks
* Recursive Mutex tasks
* Blocking Queue tasks
e Statically allocated tasks
® Suicidal tasks

4.1 Running the Basic Example for ADuCM4x50 EZ-Kit with CrossCore
Embedded Studio

4.1.1 Overview

This page describes the steps required to build and run basic example on ADUCM4x50 EZ-KIT board
using CrossCore Embedded Studio.

4.1.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.
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Software Requirement

* Anaog Devices CrossCore Embedded Studio. For more information please refer to Software
environment set up for CrossCore Embedded Studio

® FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADuCM4x50 EZ-Kit board
°* AnICE1000 or ICE2000 emul ator

Connect the ICE1000 or ICE2000 emulator to DEBUG P5 port of EZ-Kit and the host PC using USB
cable and simultaneously connect the power supply with 5 volts as in the diagram below

USB TO PC

4.1.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Select the File menu and then select the Import option from the menu and when the | mport
project window appears

® Click onthe General folder, then click on the Existing Projectsinto Wor kspace entry, and
click Next

* Click the Select root directory radio button and then click the Browse button
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* Browse the root folder where you previoudly installed the FreeRTOS product and then browse
down into the FreeRTOSv10.0.0\FreeRTOS\Demo\CORTEX_M4 ADuCM4x50 CCES
folder

® Click OK to close thefile browser dialog

® A single project should appear in the proj ects pane of the Import window
® Check the entry in the projects pane and click Finish to Import the project
|

g

27 Import = | &
Import Projects

Select a directory to search for existing Eclipse projects.

ir

(@) Select root directory:  C\Analog Devices\test_case\freertos\FreeRTOSv10. ~ Browse...
() Select archive file: v Browse...
Projects:

RTOSDemo_CCES (C\Analog Devices\test_case\freertos\FreeRTOSv10.0.0 Select All

Deselect All

i

Refresh

7 I »

Options

[] Search for nested projects

[] Copy projects into workspace

[ Hide projects that already exist in the workspace

Working sets
[] Add project to working sets New...

- Select...

@ Next > [ Finish l l Cancel

2. Choose Debug/Release mode to build the project.

File Edit Source Refactor Mavigate Search Project Run Window Help
ik s-[&f @itrariosy R IR R R

IS Project Explorer & Sk

&l
q
0

o

3. Build the project in CrossCore Embedded Studio

* IntheProject Explorer right click on the RTOSDemo_CCES project and select the Build
Proj ect option from the menu
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4.1.4 Run the Example
Follow below four steps to do debug configuration, download and run the built binary on the target

board.

1. Inthe Project Explorer right click on the RTOSDemo_CCES project and select the Debug As

option from the menu

2. From the popup menu select Debug Configur ations option to create a new debug configuration
that matches your emulator and target board

" Debug Configurations

Create, manage, and run configurations

Specify and launch an application with GDB and OpenOCD

R IEER
type filter text

4 Application with CrossCore Debugger
4 | Application with GDB and OpenOCD (Emu
@ RTOSDemo_CCES Debug
I Application with GDB and QEMU (Simulat
B Launch Group

< 1 3

Filter matched 5 of 8 items

@

3. Click the Debug button to close the Debug Configur ation window
4. Click the Run/Resume button to start running your application

File Edit Source Refactor

o~ E @l 8%

FreeRTOS User's Guide

Name: RTOSDemo_CCES Debug
[ Target . [ Main| % Debugger| & Startup| %~ Source|  Common

Command:

openocd

@) Target (processor) () Board

[Analog Devices ADuCM4050 -

Interface:

IAnaIug Devices ICE-1000 Emulator VI

Max speed:
1MHz -

Halt options

Halt peripherals on suspend

Arguments:

Mavigate Search Project Run Window Help
v Q@ i® v

m 2 = |

=

Browse...

I

Revert

)

Apply

J

Debug

||

Close

)
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4.1.5 Test Results

Output from the application should be visible within the Console window in the CrossCore Embedded
Studio IDE. Y ou should see three LEDs on the EZ-Kit begin to flash. Thetest isok for <num>
round(s) will be printed constantly and Test Passed which means the test is successful will be printed
after 25 rounds in the console.

B Console £ . ¥ Tasks|[2! Problems| & Executables| B} Debugger Console | 47 Search
RTOSDemo_CCES Debug [Application with GDB and OpenOCD (Emulator)] RTOSDemo_CCES

The test is ok for 9 round(s)
The test is ok for 10 round(s)
The test is ok for 11 round(s)
The test is ok for 12 round(s)
The test is ok for 13 round(s)
The test is ok for 14 round(s)
The test is ok for 15 round(s)
The test is ok for 16 round(s)
The test is ok for 17 round(s)
The test is ok for 18 round(s)
The test is ok for 19 round(s)
The test is ok for 20 round(s)
The test is ok for 21 round(s)
The test is ok for 22 round(s)
The test is ok for 23 round(s)
The test is ok for 24 round(s)
The test is ok for 25 round(s)

Test passed

4.2 Running the Basic Example for ADuCM4x50 EZ-Kit with IAR
Embedded Workbench

4.2.1 Overview

This page describes the steps required to build and run basic example on ADUCM4x50 EZ-KIT board
using AR Embedded Workbench.

FreeRTOS User's Guide 30



4.2.2 Environment Setup

Before running the basic example with IAR Embedded Workbench, you should make some
preparation for environment setup including software and hardware.

Software Requirement

* Analog Devices |AR Embedded Workbench. For more information please refer to Software
environment set up for IAR Embedded Workbench

* FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADuCM4x50 EZ-Kit board
* A JLinkLite

Connect DEBUG P4 port of the EZ-KIT board to a PC running IAR Embedded Workbench using the
JLink and simultaneously connect the power supply with 5 volts as in the diagram below

B

4.2.3 Build the Example

Before you run the FreeRTOS example in IAR Embedded Workbench, follow below three steps to
import and build it.

1. Select the Add Existing Project from the Project Menu and browse to the FreeRTOSv10.0.0
\FreeRTOS\Demo\CORTEX_M4 _ADuCM4x50_|AR\iar folder within the FreeRTOS product
directory and import the project
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2. Choose Debug/Rel ease mode to build the project.
File Edit View Project J-Link Toocls Window Help

DeHI St BRR| o of

~ YA D ¢

Workspace

x

lDebug

7]

Files

B [FRTOSDemo - Debug
@ [ FreeRTOS

FE O Indlude

& O3 Library

Falsre

& [ Standard_Demo
L@ [ Output

IAR Information Center for ARM |

AR I TR

/-.. /...

3. Build the project in the AR workbench
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® From the Project menu select the M ake option and enter the file name

% 12 - I4R Embedded "Warkbench IDE - ARM 7.60.1
File  Edit J-Link  Tools  Window  Help

D U E| S| | |

Wiew  Project

DD‘B 2/

A

2

£

‘Warkspace * | 18R InFormation Center for ARM

[Debug v]

Files o By
la]RTOSDem._ | v | |
@ CIFreeRTOS
@ Cinclude
= CaLibrany
Fmase

[ Standeard_..
L@ (3 Output

Guidelinesfor setting up
your project, adding
files, compiling, linking,
and debugging it.

IAR in-circuit debug and
trace probes, |AR starer
lats.

RTOS5Demo

Complete product
documentation in PDF
format gives you all the
userand reference
information you need.

For questions abaut how
to use your IAR product,
reporting a problem, or
finding support
resources

Example applications
that demonstrate
hardware peripherals for
specific devices and
evaluation boards.

All sbout the latast
features, new device
support, and program
comections.

Information on |AR
viualSTATE, RTOS
and middleware
solutions.

Here you can download
product updates,
manage licenzes and
contact information, and
checkyour SUA status.

Messages
BlockQ.c
event_groups.c
death.c
heap_4.c
flash.c

main.c

list.c

ParTestc
FallG.c
queue.c

portt.c

startup.c
recmutex.c
system.c
StaticAllocation.c
tasks.c

fimers.c

Linking

Tatal number of errors: 0
Total number of wamings: 0

4.2.4 Run the Example

Follow below two steps to do debug configuration, download and run the built binary on the target

board

1. From the Pr oject menu select the Download and Debug option

Y ou may meet the Device Selection window, please select Coretex-M4 device.
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2. The application should load and halt at main. Continue the application to see it run.

4.2.5 Test Results

Output from the application should be visible within the Terminal 1/0 window which can be found in
View menu in the AR Embedded Workbench IDE. Y ou should see three LEDs on the EZ-Kit are
blinking. Thetest isok for <num> round(s) will be printed constantly and Test Passed which

means the test is successful will be printed after 25 rounds in the console.

Terminal I

Cutput; Log file: Off

The test iz ok for 13 roundis) -
The test iz ok for 14 roundis=s)
The test i= ok for 15 round(=s)
The test i= ok for 16 roundis)
The test 1= ok for 17 roundis)
The test i= ok for 18 roundi=)
The test iz ok for 19 roundis)
The test i= ok for 20 round(=s)
The test i= ok for 21 round(=s)
The test i= ok for 22 roundis)
The test iz ok for 23 roundis)
The te=t i= ok for 24 roundi=)
The test iz ok for 25 roundis)
Te=t passed

4.3 Running the Basic Example for ADuCM4x50 EZ-Kit with Keil MDK

4.3.1 Overview

This page describes the steps required to build and run basic example on ADUCM4x50 EZ-KIT board
using Keil MDK.

4.3.2 Environment Setup

Before running the basic example with Keil MDK, you should make some preparation for
environment setup including software and hardware.

Software Requirement

* Anaog Devices Kell MDK. For more information please refer to Software environment set up
for Keil MDK

® FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready
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Hardware Setup
* An ADuCM4x50 EZ-Kit board
® A JLink Lite

Connect DEBUG P4 port of the EZ-Kit to the host PC using the J-Link connector, connect the USB
to UART port on the EZ-Kit to the host PC using the USB cable provided and simultaneously
connect the power supply with 5 volts asin the diagram below

-

4.3.3 Build the Example
Before you run the FreeRTOS example in Keill MDK, follow below four steps to import and build it.
1. Import the FreeRTOS example into Keil MDK

® Select the Open Project option from the Project menu

* Inthefiletree window browse to the FreeRTOSv10.0.0
\FreeRTOS\Demo\CORTEX_M4 ADuCM4x50 KEIL folder inthe FreeRTOS product
installation and select the RTOSDemo.uvprojx file.

® Click the Open button to import the project

2. Choose Debug/Rel ease mode to build the project.
| File | Edit View Project Flash Debug Peripherals

15 A | & B | |

| LuAD
¥4 | Release E

3. Build the project in Keil MDK
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® Select the Build Target/Rebuild All Target Files option from the Project menu

4. Configure a seria console application of your choice to view the output from the UART to USB
connection on the HOST PC

* TheKeil MDK isunable to output and text to the console within the MDK IDE.The output of
the application is transmitted via UART to the serial console. The easiest way to determine the
correct USB deviceisto view the Ports entry in the Windows Device Manager.From here
identify the COM port.Configure your serial console application to connect to the port with a

baud rate of 9600
2l Device Manager = M= M= @ PuTTY Configuration L
File &ction View Help Category:
=I- Session asic options for your Pu session
<"HE:}'___'E___' - Sessi B asic options fi PuTTY i
B o | 1 i Logging ; .
: X Specify the destination you want to connect to
45 GPANZ-DIL || B Temind izl line Speed
omC ter - Keyboard
b= Lompu - Bel COE 9600
v \l—:“ D!Sk drives - Features Connection type:
v Display adapters = Window Faw Telnet Rlogin S5H @ Serial
_---'-’;,J Hurnan Interface Devices . Appearance - pr P .
- g IDE ATASATAPL controllers - Behaviour R, BED ?I B3 @ st SEseE
b -EB Keyboards .. Translation Saved Sessions
. ji{ Mice and ather pointing devices i - Selection
o A Monitars 3 -~ Colours Default Settings Load
o ¥ MNetwork adapters = Eon;eitlon
i .. Data
Other devices . Prowy Save
iy Unknown device - Telnet Delete
7 Ports (COM & LPT) - Rilagin
Y5 Comrunications Port (COML) +1- S5H
: 5 UUSB Serial Port (COME) - Sel Clase window on exit:
bl Processors Always MNever @) Only on clean exit
- %y Sound, video and game controllers
.M Systern devices &
About Open | | Cancel

4.3.4 Run the Example

Follow below two steps to do debug configuration, download and run the built binary on the target
board

1. From the Flash menu select the Download sub-menu and then the Start/Stop Debug Session
option from Debug menu.

2. Click the Run button to start running the application

File Edit View Project Flash Debug Peripherals Tools SVCS )

FE]el see o v | [OREEES-C
Registers o @ Disassembly
—— e - [Zox0000034E ETFE
e il Ox00000350 EJFE
"o omn |[omnon o
A1 0420004008 e
A2 0X00002650 e Sl
n3 0+00000000 EEe e il
R 0+00000000 Engeesi
A5 0+00000000 Epge i
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4.3.5 Test Results

When the application runsit will blink three LEDs on the EZ-Kit, Thetest is ok for <num> round(s)
will be printed constantly and Test Passed which means the test is successful will be printed after 25
rounds on the console.
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5 Running the Examples on the ADSP-SC589 EZ-Kit

The FreeRTOS product for Analog Devices processors contains the following examples:

Processor Core Toolchain Example(s)
ADSP-SC589 ARM A5 CrossCore Embedded Studio Basic Demo
ADSP-SC589 ARM A5 CrossCore Embedded Studio Lwip Demo
ADSP-SC589 SHARC+ CrossCore Embedded Studio Basic Demo

The basic demo example is based on the Standard Demo Tasks that FreeRTOS recommend are
provided for each port of the FreeRTOS Operating System. For more information on the Standard
Demo Tasks please refer to http://www.freertos.org/a00013.html.

The tasks performed in the Analog Devices Basic Demo include:
® LED flash
* Polled queue tasks
* Recursive Mutex tasks
* Blocking Queue tasks
e Staticaly allocated tasks
* Suicidal tasks

5.1 Running the Basic Example for ARM on ADSP-SC589 EZ-Kit with
CrossCore Embedded Studio

5.1.1 Overview

This page describes the steps to build and run basic example for ARM on ADSP-SC589 EZ-Kiit board
using CrossCore Embedded Studio.

5.1.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.
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Software Requirement

® Analog Devices CrossCore Embedded Studio. For more information please refer to Software
environment set up for CrossCore Embedded Studio

* FreeRTOS product and the Analog Devices FreeRTOS product. For more information please
refer to Get the source code ready

Hardware Setup
* An ADSCP-SC589 EZ-Kit board
* An ICE1000 or ICE2000 emulator

Connect the ICE1000 or ICE2000 emulator to DEBUG P3 port of EZ-Kit and the host PC using USB
cable and simultaneously connect the power supply with 5 volts asin the diagram below.

UsSB TO PC

Connect the USB to UART port of the EZ-Kit to the host PC with a USB cable as shown below:
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USB TO PC

5.1.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Import the FreeRTOS example into CrossCore Embedded Studio:
* Select the File menu and then select the Import option from the menu

® Click onthe General folder, then click on the Existing Projectsinto Workspace entry, and
click Next

® Click the Select root directory radio button and then click the Browse button

* Browse the root folder where you previously installed the FreeRTOS product and then browse
down into the FreeRT OSv10.0.0\FreeRTOS\Demo\CORTEX_A5 ADSP_SC589 CCES
folder

® Click Finish to close the file browser dialog
® A single project should appear in the proj ects pane of the Import window

® Check the entry in the projects pane and click Import
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#T Import
Import Projects

Select a directory to search for existing Eclipse projects.

]
n 8
I U

@) Select root directory: C\Analog Devices\test_case\freertos\FreeRTOSv10. + Browse...
() Select archive file: v Browse...
Projects:

RTOSDemo_CCES_Corel (ChAnalog Devices\test_case\freertos\FreeRTOS Select All

Deselect All

Refresh

i1

< | il P

Options

[ Search for nested projects

["] Copy projects into workspace

[ Hide projects that already exist in the workspace

Working sets
[ Add project to working sets MNew...

Working sets: hd Select...

® Next = [ Finish ] l Cancel

2. Choose Debug/Rel ease mode to build the project.
Edit Source Refactor Navigate Search P
E*:I'QE?“‘ v Q-

roject Explorer 1 Debug T =0
5 RTOSDemo ¢ Y. 2 Release
& Binaries

e Includes

& Debug

&= FreeRTOS

&= Include

= Release

& Source
Standard_Demo

[ .

3. Build the project in CrossCore Embedded Studio:

* IntheProject Explorer right click onthe RTOSDemo CCES Cor €0 project and select the
Build Project option from the menu
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5.1.4 Run the Example

The semihosting I/0O mechanism, which writes to the CCES consol e during debug sessions, uses SWI
interrupts. Thisisincompatible with default GCC-compiled I/O code which also uses SWI interrupts.
For this reason, stdio function callsinitiated on the ARM core are routed out over UART instead and
shall be read with a serial terminal external to CCES. Importantly, note that:

1. Thisiscurrently only supported within FreeRTOS threads, any stdio function call performed
outwith athread will crash the application.

2. If you need to use other peripherals, you should take care not to change the power service clock
rate (which is set in the UART 1/O device).

Before running the example, you need to setup the serial terminal of your choice to read the Cortex
core output from the UART to USB connection on the HOST PC. The easiest way to determine the
correct USB device isto view the Ports entry in the Windows Device Manager. From here identify

the COM port. Configure your serial console application to connect to the port with a baud rate of
115,200.

=1 Device Manager = [ B |[=a] R PUTTY Configuration (7=
File  Action  Wiew Help Categony:

<|'_-£-‘ 'E:}' | = | r‘; | E =7 | 141 | s :'R '..'); B- Slession B asic optionz for your PuT T session

- — = . L.Dgglng Specify the destination you want to connect to
4 = EDIN-INTRM-D01 - = Teminal B

ol Cormouter 1 .. Keyboard Seridl line ~ Speed
I i - Bell COME 115200
> -®F CrossCore Tools :
Disk diives - Features Connection type:
S — i - Wwindow ) Raw () Telnet (7 Rlogin (01 55H @ Seiial
B Display adapters - Appearance
ity DWD/TD-ROM drives - Behaviour Load, save or delete a stored session
B L5 Human Interface Devices ... Trarslation Saved Sessions
b= Keyboards g - Selection 5CH89_EZ_UART
ﬂ Mice and other pointing dewvices 1 - Colours ;
- Manitars = Connection
b -F MNetwork adapters - Data
S - Promy
a7 Ports (COM B LPT) Telnet
P L - Telnel
i 75 Comrmunications Port (COMI) :
PR : - Rlogin
T 7' USB Serial Port {COM3) - S5H
-2 Processors - Serial

5 ! Close window on exit:
A Replay Virtual SCSL Adapters (7 Abways Mever @) Orly on clean exit
- [12 Security Devices

b & Sound, video and garne controllers

[ About | | Help I | Open | [ Cancel |

After this, follow below five stepsto do debug configuration, download and run the built binary on
the target board.

1. Inthe Project Explorer right click onthe RTOSDemo_CCES Core0 project and select the
Debug As option from the menu

2. From the popup menu select Debug Configurations option to create a new debug configuration
that matches your emulator and target board
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" Debug Configurations

Create, and run figurations ﬁ\
Select a debug session to launch and a program to load

S INEER Narmie: RTOSDemo_CCES_Core0 Debug

type filter text

— — aSﬁsian % Automatic Breakpoints| B3 Target OptinnsH% Custom Board Support| & Multiprocessor Groups| % Source| £] Common

4 Application with CrossCore Debugger Session configuration
|& RTOSDemo_CCES_Corel Debug | —_—
i Application with GDB and OpenOCD (Emulaton) Targek Emiation bepug aiget Select Session...
& Application with GDE and QEMU (Simulator) Plationm; AR SCEIMa 1100

¥ Launch Group Processor: ADSP-SC589

The following program(s) will be loaded:

Program Options Silicon revision Add...

4 < Device 0 [Core 0] IE
21 C\Analog Devices\CrossCore Embedded Studio 2.7.0\SHARC\|dr\ezkitSC589_preload_core Reset, Run after load not available =
] RTOSDemo_CCES_Core0\Debug\RTOSDemo_CCES_Cored Check si-revision, Run after load not available Remove...

4 @ Device 0 [Core 1] |m
[T <Click here to select a program to load> (RSN e

WD e

[T «Click here to select a program to load> =
Move Down

Restore Defaults...

Filter matched 5 of 15 items Revert Apply

)

[ Debug 1 ‘ Close J

(

3. Disable the semihosting function in Automatic Breakpoints

r
7 Debug Configurations

Create,  and run i

Specify and launch a CrossCore Embedded Studic program

> m )
LExX | B 3~ Name: RTOSDemo_CCES Corel Debug
% Session | %g Autematic Breakpoints @ Target Optlonq Lﬁ Custom Board SUpporﬂ £ Multiprocessor Groupq 73 SDUI'CEW i=] gommorq
4 Application with CrossCore Debugger Processorn
E R.TOEI;DemoiCCEiCoreﬂ Debug [Daviceﬂ [Care 0] { Cortex-A5 ) v]
4 Application with GDB and OpenOCD (Emulator) I
fl i Application with GDB and QEMU (Simulator) Breakpoints to set automatically after load: |
@ Launch Group Description HNew... M
B Launch Group (Deprecated) Il
Edit...
Delete... I
i
Delete All.. Il
I
I
I
I
I
I
ol
i
"]
i
["] Enable semihosting i
4 m 3 I
. 3 Revert Apply
Filter matched 6 of 6 items M

® [ Debug ] l Close

4. Click the Debug button to close the Debug Configur ations window
5. Click the Run/Resume button to start running your application
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File Edit Source Refactar Navigate Search Project Target Run Window Help
mi |G & eo|m]n 2.2 8m E R R B R HO R R SRR R AR

- Deoug -
4 4 RTOSDemo_CCES_Core0 Debug [Application with CrossCore Debugger]
4 [ ADSP-SC589 via ICE-1000
4 |1 Device 0 [Core 0] { Cortex-A5 ) [Debug\RTOSDemo_CCES_Core0] (Suspended : Breakpoint)
= main(int, char®*) at main.c:133 Oxc1014%aa
+@ Device 0 [Core 1] { SHARC ) (Running : User Request)
#® Device 0 [Core 2] ( SHARC ) (Running : User Request)

5.1.5 Test Results

Output from the application should be visible withinthe TTY terminal (e.g. PUTTY/TeralTerm). You
should see the LEDs on the EZ-Kit begin to flash. Test Passed will be printed if all the tests passed.

5.2 Running the Basic Example for SHARC+ on ADSP-SC589 EZ-Kit with
CrossCore Embedded Studio

5.2.1 Overview

This page describes the steps to build and run basic example for SHARC+ on ADSP-SC589 EZ-Kit
board using CrossCore Embedded Studio.

5.2.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.

Software Requirement

* Anaog Devices CrossCore Embedded Studio. For more information please refer to Software
environment set up for CrossCore Embedded Studio

* FreeRTOS product and the Analog Devices FreeRTOS product. For more information please
refer to Get the source code ready

Hardware Setup
* An ADSCP-SC589 EZ-Kit board
* An ICE1000 or ICE2000 emulator
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Connect the ICE1000 or ICE2000 emulator to DEBUG P3 port of EZ-Kit and the host PC using USB
cable and simultaneously connect the power supply with 5 volts asin the diagram below.

USB TO PC

5.2.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Import the FreeRTOS example into CrossCore Embedded Studio:

Select the File menu and then select the Import option from the menu

Click on the General folder, then click on the Existing Projectsinto Workspace entry, and
click Next

Click the Select root directory radio button and then click the Br owse button

Browse the root folder where you previously installed the FreeRTOS product and then browse
down into the FreeRTOSv10.0.0\FreeRTOS\Demo\SHARC_ADSP_SC589 CCESfolder

Click Finish to close the file browser dialog
Two projects should appear in the Project Explorer
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2 Irnport
Import Projects

Select a directory to search for existing Eclipse projects.

(1 Select archive file:

Projects:

@ Select root directony:  ChAnalog Devices\test_case\FreeRTOS\free -

Browse...

0
ﬁ}' g
L

Browse...

4 | 1

RTOSDemo_CCES_SHARC_Corel (Ch&nalog Dewvicesitest_case'Fn
RTOEDermo_CCES_SHARC Corel (ChAnalog Devices\test_casetfn

Options

[T]search for nested projects

[Tl Copy projects inta workspace

[T Hide projects that already exist in the workspace

Working sets

[(ladd project to working sets

i

Select All

Deselect All

Refresh

e, .

Select..,

Cancel

2. Choose Debug/Rel ease mode to build the project.

Edit Source Refactor Navigate Search P
E-f.'-'%{;m v Q-

roject Explorer Debug F=°
5 RTOSDemo_C v 2 Release |

& Binaries

mi Includes

& Debug

= FreeRTOS

& Include

= Release

& Source

Standard_Demo

-

3. Build the project in CrossCore Embedded Studio:
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* IntheProject Explorer right click onthe RTOSDemo CCES SHARC_Core0 and
RTOSDemo CCES SHARC_Corel project, then select the Build Project option from the

menu

5.2.4 Run the Example

Follow below five steps to do debug configuration, download and run the built binary on the target

board.

1. Inthe Project Explorer right click onthe RTOSDemo_CCES SHARC_Core0 project and select
the Debug As option from the menu

2. From the popup menu select Debug Configur ations option to create a new debug configuration
that matches your emulator and target board

File Edit Source Refactor
| &~ & ~
(75 Project Explarer 52

4 % > RTOSDermo_CCES SH
44 Binaries

i

1 Includes
& sre

3 > system
(= Debug

B - systemosve
(25 » RTOSDermo_CCES SH

7 Debug Configurations

Create, manage, and run configurations

€3 Vou must select a debug session first

=X | B3~
type filker text
a | Application with CrossCore Deb

L RTOSDerma_CCES SHARC Cor

I Application with GDE and Open

I Application with GDE and QEMU {

B Launch Group

.

Filter matched 5 of 16 items

@

Mame: RTOSDemo_CCES_SHARC Cored Debug

22

s

7 Session . %% Automatic Breakpeint| (3 Target Options | ¥ Custom Board Support| $8 Multiprocessor Group | B2 Source| ™)

uc
7 Session Wizard
[o]]
Select Processor

Chaoose a target processar.

o o]

Processor family: SHARC

Processor type:

< ADSP-21584
G ADSP-21587
< ADSP-SCST0
< ADSP-SCSTL
< ADSP-SCST2
4 ADSP-SCST3
< ADSP-SC562
4 ADSP-SC563
< ADSP-SC5E4
< ADSP-SCSET
4 ADSP-SC569

Show all processars

7] Use selected project to create new session

<

(5 RTOSDero_CCES_SHARC Cored

® [

< Back

Finish

Configurater..
Cancel

Select Session...

Add..

Edit...

Remove..,

Remave All..,

WMowe Up

Move Down

Restore Defaults..,

Rewvert

Debug

Apply

Clase

3. Click the Debug button to close the Debug Configur ationS window
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BT mmes el NT Dabug Configurations 5] ey
File Edit Source Refactor .
N Create, manage, and run configurations Z
it | ® -]~ o o < g (@) CMSIS Pack Manager
Select a debug session to launch and a program to load J
[ Project Explorer 52 =g
4 % > RTOSDemo_CCES_SH TICEY
> ) B 5 Mame: RTOSDema_CCES SHARC_Cored Debug
» #F Binaries
» &l Includes type filter text "B Session . % Autamatic Breakpoint | [¥) Target Options | ¥4 Custom Board Support| S Multipracessor Group | % Saurce| ™1
> U e 4 [ Application with CrossCore Debuc || gssion configuration
> (55 system 1 RTOSDemo_CCES_SHARC Cor
+ = Debug G Application with GDB and Openon ||| | 2rdet: Emulation Debug Target
B - system.sve Id Application with GDE and QEMU | Platform: ADSP-5C598 via ICE-1000
» £ > RTOSDemo_CCES_SH  Launch Group Processar: ADSP-SC580
The following prograrm(s) will be loaded:
Program Options Silicon revision Ldd...
4 G Device 0 [Core 0] =
[T CivAnalog Devices\CrossCare Reset, Run after load not available
[7] RTOSDermo_CCES SHARC_Ce Check si-revision, Run after load not available oo
4 G Device 0 [Core 1]
[] RTOSDemo_CCES SHARC_Ct Reset, Check si-revision, Run after load 1.0 Rernowe All..
4 4@ Device 0 [Core 2] Mows Up
[ <Click here ta select a progra
Wave Down = 0
Restore Defaults... B x *B-6-
Revers
Filter matched 5 of 16 iterms PEY

< m b

(5 RTOSDero_CCES_SHARC Cored

4. Choose Core0 and click the Run/Resume button to start running Core0 application

File  Edit Source Refactor MNawvigate Search  Project  Target BRun  Window Help
Y~ Bl dopllmze el 8mn e Qi P A0~
%5 Debug i3 Resume (F5) - = 7 I/

a | RTOSDerno_CCES SHARC Carel Debug [Application with CrossCare Debugger]
4 B ADSP-5C573 via ICE-1000
a ¥ Device O [Core U] { Cortex-A53 ) [DebughRTOS0emo_CCES SHARC _Corell] (suspended : Breakpoint)
= main{ at RTOSDermo_CCES_SHARC Coarel.c:17 0x39004F9c
e Deice ULore 1] sHARL ) [Debughh TUSDemo_ULES_sHARL _Uare L dxe| (hunming @ User Request)
p2 Device 0[Core 2] { SHARC ) (Running : User Request)

5. Then Choose Corel and keep to click Run/Resume button to start running Corel application
Eile Edit Zource Refactor [Mawigate Search Project Target Bun  Window Help
i=<J}' |um§%‘0|é{-§?up @R?.“:V-U;f|‘\:ﬁ'l.u.l :t‘;;v%v@ Q;.vé -

%5 Debug 53 Resurne (F5) - = H

4 | RTOSDermo_CCES_SHARC Corel Debug [Application with CrossCaore Debugger]
a 2 ADSP-5C573 wia ICE-1000

[ | are (] rrte- Oebpgh BTN e mn HAR arell LBy er Beoye

4 | Dewice D [Care 1] { SHARC ) [DebugiRTOSDemo_CCES SHARC_Corel.dxe] (Suspended : Breakpoint)
= rmainfint, char™) at main.c:134 Txlc229e

p Device 0 [Core 2] { SHARC ) (Running : User Request)
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5.2.5 Test Results

Output from the application should be visible within the Console window in the CrossCore Embedded
Studio IDE. Y ou should see three LEDs on the EZ-Kit begin to flash. Test Passed will be printed if

the all tests passed.

File Edit Source Refactor Mavigate Search Project Target Run Window Help

irg- | Bid| decdrn @ | @ m - Qi@ ITRE R RoR R Quick Access | [ | BB C/C++ (1 Debug |88 CMSIS Pack Manager
45 Debug 2 = = B |[t9= ariables | ® Breskpaints 52 _Iif Registers| B Modules ® % E R|BESG Y= 0O

4 [ RTOSDemo_CCES_SHARC_Corel Debug [&pplication with CrossCore Debugger]
4 () ADSP-SC588 via ICE-1000
@ Device 0 [Core 0] { Cortex-A5 ) [Debug\RTOSDemo_CCES_SHARC _Corel] (Running : User Request)
@ Device 0 [Core 1] ¢ SHARC ) [DebughRTOSDemo_CCES_SHARC_Coreldxe] (Running : User Request)
@ Device 0 [Care 2] { SHARC ) (Running : User Request)

[£] RTOSDemo_CCES SHARC Corel.c 52

adi_initComponents();

=
* The default startup code does not include any functionality to allou|
* core @ to enable core 1 and core 2. A convenient way to enable

* core 1 and core 2 is to use the adi_core_enable function.

*

adi_core_enable(ADI_CDRE_SHARCE);

f*adi_core enable(ADI_CORE_SHARCL);*/

B Consele 32 4] Tasks | [£ Problems | {3 Executables| G3 Debugger Conscle| =g Pragress | & Call Hierarchy

Output
Test passed
Test passed
Test passed
Test passed
Test passed
Test passed
Test passed
Test passed
Test passed
Test passed
Test passed

¥ [function: _exit] [type: Ternporary]

= O |[B= outline | [ Memory |2 Disassembly 52 = 8
- Enter lacation here | TR |
<

Mo debug context

R #E-f-=18

Writable Smart Insert 076

5.3 Running the LwIP Example for ARM on ADSP-SC589 EZ-Kit with

CrossCore Embedded Studio

5.3.1 Overview

This page describes the steps to build and run the LwlP Example for ARM on ADSP-SC589 EZ-Kit

with CrossCore Embedded Studio.

5.3.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.

Software Requirement

® Analog Devices CrossCore Embedded Studio. For more information please refer to Software
environment set up for CrossCore Embedded Studio
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* FreeRTOS product and the Analog Devices FreeRTOS product. For more information please
refer to Get the source code ready

Hardware Setup
* An ADSCP-SC589 EZ-Kit board
e An |CE1000 or ICE2000 emulator

Connect the ICE1000 or ICE2000 emulator to DEBUG P3 port of EZ-Kit and the host PC using USB
cable, connect the target board to the same LAN as PC using standard network cable and
simultaneously connect the power supply with 5 volts as in the diagram below.

USB TO PC

USB TO PC
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5.3.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Import the FreeRTOS example into CrossCore Embedded Studio:

Select the File menu and then select the Import option from the menu

Click on the General folder, then click on the Existing Projectsinto Wor kspace entry, and
click Next

Click the Select root directory radio button and then click the Browse button

Browse the root folder where you previously installed the FreeRTOS product and then browse
down into the FreeRTOSv10.0.0
\FreeRTOS\Demo\CORTEX_A5 ADSP_SC589 CCES_LwIP folder

Click Finish to close the file browser dialog
A single project should appear in the Project Explorer
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27 Import
Import Projeds

Select a directory to search for existing Eclipse projects,

@) Select root directony:  CihvAnalog Dewvicestfreertos\FreeRTOS10,0.0 -

) Select archive file:

Projects:

=1 =R IEE

| B

Browise...

Browse...

1 | 1

DnsClient_FreeRTO5_A5 (Chanalog Devices\freertoshFreeRTO Sl

Options

[7] Search for nested projects

[7] Copy projects into warkspace

[T Hide projects that already exist in the workspace

Wfarking sets

[]add project to swarking sets

Select Al

Deselect All

1

Refresh

lewy,..

Select,.,

@ Mest = | [ Finish

Cancel

2. Choose Debug/Release mode to build the project.

Edit Source Refactor Navigate Search P
B4 L; b v Qv
roject Explorer 1 Debug 1 —

5 RTOSDemo_¢ ¥ 2 Release

& Binaries

ni Includes

& Debug

= FreeRTOS

& Include

= Release

& Source

Standard_Demo

I

3. Build the project in CrossCore Embedded Studio:
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* IntheProject Explorer right click on the DnsClient_ FreeRTOS A5 project and select the
Build Project option from the menu

5.3.4 Run the Example

The semihosting I/0O mechanism, which writes to the CCES consol e during debug sessions, uses SWI
interrupts. Thisisincompatible with default GCC-compiled I/O code which also uses SWI interrupts.
For this reason, stdio function callsinitiated on the ARM core are routed out over UART instead and
shall be read with a serial terminal external to CCES. Importantly, note that:

1. Thisiscurrently only supported within FreeRTOS threads, any stdio function call performed
out with athread will crash the application.

2. If you need to use other peripherals, you should take care not to change the power service clock
rate (which is set in the UART 1/O device).

Before running the example, you need to setup the serial terminal of your choice to read the Cortex
core output from the UART to USB connection on the HOST PC. The easiest way to determine the
correct USB device isto view the Ports entry in the Windows Device Manager. From here identify
the COM port. Configure your serial console application to connect to the port with a baud rate of
115,200.

=5 Device Manager = @ ﬁ PuTTY Configuration [%7] SE
File  Action  Wiew Help Categony
<',-1'| ’E'} | i | E! | E BB | L) | [ f'g ._.p; — - Siession . B azic optionz far your PUTTY seszion
e i L.oggmg Specify the destination you want to connect to
4 = EDIM-INTRM-D01 - = Teminal F
= : - Keyboard Serial line _ Speed
I F - Bell COME 115200
: B CrossCore Toals -
D et - Features Connection type:
i =1 Window 1 Raw () Telnat Rlogin (71 55H @ Serial
B Display adapters
i, _ - Bppearance :
it DWD/CD-ROM drives . Behaviour Load, save or delete 3 stored session
[ --'33&‘, Human Interface Devices ... Tranzlation Saved Sessions
> 5 Keyboards A - Gelection 5C589_EZ UART
b "ﬂ Mice and other pointing dewvices 1 Eoloyrs Default Settings | Load |
.| Monitors [=- Connection _5'}315&,.'_‘35;: Z LUaR i
-&F Netwark adapters ----gata ! | save
4 "5 Ports (COM & LPT) IR |
. s = - Telnet | Delete |
i w5 Comrmunications Port (COMI :
P - - Rlogin
P ' USB Serial Port {COMS) - G5H
-J A Processors v el Close window on exit
"_ Replay Virtual SCS1 Adapters 1 Alwayps Mewver @ Only on clean exit
p - Security Dewvices
. -%y  Sound, video and game controllers i
T =i T | About | | Help | | Open | [ Cancel |

Follow below five stepsto do debug configuration, download and run the built binary on the target
board.

1. Inthe Project Explorer right click on the DnsClient_FreeRTOS A5 project and select the Debug
As option from the menu
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2. From the popup menu select Debug Configur ations option to create a new debug configuration
that matches your emulator and target board

7 Debug Configurations

Create, manage, and run configurations

€9 You must select 3 debug session first

K IR
type filter text

4 Id Applicstion with CrossCore Debugger
I DnisClient_FreeRTOS_AS Debug
I Application with GDB and Open0CD (Ernulator
1 Application with GDB and QEMLU (Simulatar)
B Launch Group

< m 3

Filter matched 5 of 11 items

Y
@

Marne: Y
% Sessi
Sessio
Targef
Platfol
Proce:
The fo

Prog

7 Session izard

Select Processor

Chaose a target processor,

Processor family: SHARC

Processor type:

& ADSP-21584
& ADSP-21587
& ADSP-SCSTO
R ADSP-SCSTL
< ADSP-SCST2
< ADSP-SCSTY
< ADSP-SC582
< ADSP-SC583
& ADSP-SC584
& ADSP-SC58T
< ADSP-SC580

m

[ Show all processors
Use selected project to create new session

@ Help <Back

Finish

Configurator...
Cancel

ions

3. Disable the semihosting function in Automatic Breakpoints

=2

&

ups | 5 Source| [ Comman

Select Session..,

Silicon rewision Add...
Edit...
Rernowe,.
| Removedll.. |
Move Up

Iowve Dowm

Restore Defaults..,

Revert

Apply

Debug

Close

.7 Debug Configurations

Create, manage, and run configurations

Specify and launch 3 CrossCore Embedded Studio program

K IR
type filter text
4 [ &pplication with CrossCore Debugger
1 DnsClient_FreeRTOS_AS Debug
I Application with GDB and Open0CD (Emulatar)
1 Application with GDE and QEMLU (Simulatar)
& Launch Group
B Launch Group (Deprecated)

Filter matched & of 8 iterns

Mame: DnsClient_FreeRTOS_A5 Debug

=W Session [ Oo Automatic Breakpoints

Processor:

[T Target Options | 44 Custam Board Support| §3 Multipracessor Groups | - Source | (] Common

[Device 0 [Core 0] ¢ Cortexas )

Ereakpoints to set automatically after load:

Label Description Hew,
V]
. Edit..
[ ]
[ ] Delete...
. Delets L.,
[ ]
[ClEnable semihosting
Reyert Apply

4. Click the Debug button to close the Debug Configur ations window
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7 Debug Configurations

Create, and run

Select a debug session to launch and a program to load

- e
S X| B Mame: DnsClient_FreeRTOS A5 Debug
type filter text = Session . O Automatic Breakpoints | [y Target Options | b

¥4 Custorn Board Support| & Multipracessor Groups | ' Seurce | [[] Common
4 [ Application with CrossCare Debugger

Sessian configuration
L DnsClient_FreeRTOS A5 Debug

Target: Ernulation Debug Target ————
I Application with GDB and OpenOCD (Emulator o SRR i o Select Session..,
& Application with GDB and QEMU (Simulator) Platform: ADSP-SC589 via ICE-1000 [selectSesson.,
@ Launch Group Processor: ADSP-SC589

The following program(s) will be loaded:
Program

Options
4 < Device 0 [Core 0]

Silicon revision Add...
[] Ci\Analog Devices\CrossCare Embedded Studio 2.7.00HARC drezkitSC589, Reset, Run after load
O DhsClient_FreeRTOS_ANDebughDnsClient_FreeRTOS_AS
4 @ Device 0 [Core 1]
[ «Click here to selecta program to load >

Remove &ll...
a4 @ Device 0 [Core 2]

) have U
[ <Click here to select 3 program ta load > B

" Edit...
not available

Check si-revision, Run after l[oad  not available Remowve...

Mowve Down

Restore Defaults...

< m

Rewert [ appry |
Filter matched 5 of 11 iterns PRY

A
@

5. Click the Run/Resume button to start running your application
Hm s | @i & o]l @2 2.0 M R R R R IR TR A R R
45 Debug 2

a | DnsClient_FreeRTOS_AS Debug [8pplication with CrossCore Debugger]
a (2 ADSP-5C584 via ICE-1000

4 o Device 0 [Core 0] { Cortex-A5 ) [DebughDnsClient_FreeRTOS_AS] (Suspended : Breakpaint)
= main) at app_main.c:79 Jxc140316e
p& Device 0 [Care 1] { SHARC ) {(Running : User Request)
o Device 0 [Core 2] { SHARC ) (Running : User Request)

5.3.5 Test Results

Output from the application should be visible within the TTY terminal (e.g. PUTTY/TeralTerm). You

should see link is established, and | P ADDRESS assigned from DHCP server will be printed after
you install the LwlIP.
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6 Running the Examples on the ADSP-SC584 EZ-Kit

The FreeRTOS product for Analog Devices processors contains the following examples:

Processor Core Toolchain Example(s)

ADSP-SC584 ARM A5  CrossCore Embedded Studio  Basic Demo
ADSP-SC584 ARM A5  CrossCore Embedded Studio  Lwip Demo
ADSP-SC584 SHARC+  CrossCore Embedded Studio  Basic Demo

The basic demo example is based on the Standard Demo Tasks that FreeRTOS recommend are
provided for each port of the FreeRTOS Operating System. For more information on the Standard
Demo Tasks please refer to http://www.freertos.org/a00013.html.

The tasks performed in the Analog Devices Basic Demo include:
® LED flash
* Polled queue tasks
* Recursive Mutex tasks
* Blocking Queue tasks
e Staticaly allocated tasks
* Suicidal tasks

6.1 Running the Basic Example for ARM on ADSP-SC584 EZ-Kit with
CrossCore Embedded Studio

6.1.1 Overview

This page describes the steps to build and run basic example for ARM on ADSP-SC584 EZ-Kiit board
using CrossCore Embedded Studio.

6.1.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.
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Software Requirement

® Analog Devices CrossCore Embedded Studio. For more information please refer to Software
environment set up for CrossCore Embedded Studio

® FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADSCP-SC584 EZ-Kit board
* An |CE1000 or |CE2000 emul ator

Connect the ICE1000 or ICE2000 emulator to DEBUG P1 port of EZ-Kit and the host PC using USB
cable and simultaneously connect the power supply with 12 volts as in the diagram below.
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6.1.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Import the FreeRTOS example into CrossCore Embedded Studio:
* Select the File menu and then select the Import option from the menu

® Click onthe General folder, then click on the Existing Projectsinto Wor kspace entry, and
click Next

® Click the Select root directory radio button and then click the Browse button

* Browse the root folder where you previously installed the FreeRTOS product and then browse
down into the FreeRT OSv10.0.0\FreeRTOS\Demo\CORTEX_A5 ADSP_SC584 CCES
folder

® Click Finish to close the file browser dialog
* A single project should appear in the proj ects pane of the Import window

® Check the entry in the projects pane and click Import
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#T Import
Import Projects

Select a directory to search for existing Eclipse projects.

(@) Select root directory: C\Analog Devices\test_case\freertos\FreeRTOSv10. =
() Select archive file: v

Projects:

ir

]
o
£3

Browse...

Browse...

RTOSDemo_CCES_Corel (ChAnalog Devices\test_case\freertos\FreeRTOS

< | il P

Options

[ Search for nested projects

["] Copy projects into workspace

[ Hide projects that already exist in the workspace

Working sets

[ Add project to working sets

i1

Select All

Deselect All

Refresh

MNew...

Select...

@ Mext = [ Finish ] l

Cancel

2. Choose Debug/Rel ease mode to build the project.
Edit Source Refactor Mavigate Search Pro
.i':"‘.".:"m W'Q'E

roject Explorer "1 Debug ’-- =5
& RTOSDemo. ( v 2 Release |

¥ Binaries

i Includes

& Debug

& FreeRTOS

& Include

= Release

& Source

& Standard_Demo

2 Quetam

3. Build the project in CrossCore Embedded Studio:

* IntheProject Explorer right click onthe RTOSDemo_CCES Cor €0 project and select the

Build Project option from the menu
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6.1.4 Run the Example

The semihosting I/0O mechanism, which writes to the CCES consol e during debug sessions, uses SWI
interrupts. Thisisincompatible with default GCC-compiled I/O code which also uses SWI interrupts.
For this reason, stdio function callsinitiated on the ARM core are routed out over UART instead and
shall be read with a serial terminal external to CCES. Importantly, note that:

1. Thisiscurrently only supported within FreeRTOS threads, any stdio function call performed
outwith athread will crash the application.

2. If you need to use other peripherals, you should take care not to change the power service clock
rate (which is set in the UART 1/O device.)

Before running the example, you need to setup the serial terminal of your choice to read the Cortex
core output from the UART to USB connection on the HOST PC. The easiest way to determine the
correct USB device isto view the Ports entry in the Windows Device Manager. From here identify
the COM port. Configure your seria console application to connect to the port with a baud rate of
115,200.

=1 Device hManager EI@ ﬁ PuTTY Configuration @
File  Action  “iew Help Categony:
<‘,E| IE:} | 5 | D | E i | 8l | _..=> & .p‘} =5 Séesls_u:n . Bazic options for pour PUTTY sezsion
i bogang Specify the destination wou want to connect ba
4= GPANZ-D01 -~ =I- Terminal .
- ) Serial line Speed
g8 Carnputer - keyboard COM25 115200
. -EF CrossCore Tools - Bell
T s - - Features Connection type:
- Disk d
4 i - Windaw Raw () Tehet O Rlogin (O 55H @ Seial
B Display adapters
S . - A ppEarance Load delet ored .
b -J;J Human Interface Devices - Behaviour oad, save or delete a stored session
b g IDE ATASATART cantrallers .. Translation Saved Sessions
[ Keyboards .. Selection SCHB4_EZ_UART
) Mice and ather pointing devices = - Calaurs Default Satings
s E ) Load
B Manitors —I- Connection SCH34 EZ UART \LI
b ¥ Metwork adapters - Data Save
T - - Prowy
-5 Other devices
. Dielet
477 Ports (COM & LPT) ;TD'”'ITE |mRoitom
:.'7 Corarmunications Port (COML) f--SSI-gl
: o' LUSB Serial Port (COM2T) L Serial ) .
: D Processors Cloge window on exit:
- ) Alveays Mever @) Only on clean exit
--By ound, video and garme controllers
1M Spstern devices
ST = N FOURRY [ TR Y ) - PP P i
| About | | Help | [ Open ] | LCancel |

Follow below five steps to do debug configuration, download and run the built binary on the target
board.

1. In the Project Explorer right click on the RTOSDemo_CCES _Cor €0 project and select the
Debug As option from the menu

2. From the popup menu select Debug Configur ations option to create a new debug configuration
that matches your emulator and target board
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7 Debug Configurations

Create, manage, and run configurations

Select a debug session to launch and a program to load

CEX &3 Name: RTOSDema_CCES_Cored Debug
type filter text % Session . 9 Automatic Breakpomtﬂ [0 Target Opt\onﬂ i Custom Board Supporﬂ & Multiprocessor Groupﬂ By Sourca =] Commonw
a | Application with CrossCore Debugger Session configuration

E RTOSDemo_CCES_Corel Debug

Target: Emulation Debug Target
I Application with GDB and OpenOCD (Em “asliniiiaiLs us o Select Session,
& Application with GDB and QEMU (Simulai Platform: ADSP-5C584 via ICE-1000
= Launch Group Processor: ADSP-5C584

The following programis) will be loaded:

Program Options Silicon revision m

4 %@ Device 0 [Core0]
[ CvAnalog Devices\CrossCore Embedded Studio 2.7.0\SHAF Reset, Run after load not available
[7] RTOSDeme_CCES Cored\Debug\RTOSDemo CCES Cored  Check si-revision, Run after load  not available Remove...
4 %@ Device 0 [Corel]
[ «Click here to select a program to load=
a %@ Device 0 [Core2]
[T «Click here to select a program to load>

Edit...

Move Up

Move Down

Restore Defaults...

q T 3
Revert Appl
Filter matched 5 of 8 iterns [ Vel ] [ PPY ]

® I Debug I [ Close ]

3. Disable the semihosting function in Automatic Breakpoints

r
7 Debug Configurations

Create, ge, and run ig

Specify and launch a CrossCore Embedded Studic program

> m )
LExX | B 3~ Name: RTOSDemo_CCES Corel Debug
% Session | %g Autematic Breakpoints @ Target Optlonq Lﬁ Custom Board SUpporﬂ £ Multiprocessor Groupq 73 SDUI'CEW i=] gommorq
i Application with CrossCore Debugger Processor
E R.TOEI;DemoiCCEiCoreﬂ Debug [Daviceﬂ [Care 0] { Cortex-A5 ) v]
4 Application with GDB and OpenOCD (Emulator) I
fl i Application with GDB and QEMU (Simulator) Breakpoints to set automatically after load: |
@ Launch Group Description New... i
B Launch Group (Deprecated) Il
Edit...
Delete... Il
i
Delete All.. Il
I
I
I
I
I
I
ol
i
"]
i
["] Enable semihosting i
4 m 3 I
. 3 Revert Apply
Filter matched 6 of 6 items M

® [ Debug ] l Close

4. Click the Debug button to close the Debug Configur ations window
5. Click the Run/Resume button to start running your application
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File Edit Source Refactor Mavigate Search Project Target Run  Window Help
- B dop]n B2 $® ts v Qi@ v

%5 Debug 22
4 [ RTOSDeme_CCES_Cored Debug [Application with CrossCare Debugger]
4 1 ADSP-5CS584 via ICE-1000
a 8 Device0 [Core0] ( Cortex-A5 ) [Debug\RTOSDemo_CCES_Corel] (Suspended : Breakpoint)
= rmain(int, char™} at main.c:133 0x890149a6
u& Device 0 [Corel] ( SHARC ] (Running : User Request)
u& Device 0 [Core 2] ( SHARC ] (Running : User Request)

6.1.5 Test Results

Output from the application should be visible within the TTY terminal (e.g. PUTTY/TeralTerm). You
should see the LEDs on the EZ-Kit begin to flash. Test Passed will be printed if all the tests passed.

6.2 Running the Basic Example for SHARC+ on ADSP-SC584 EZ-Kit with
CrossCore Embedded Studio

6.2.1 Overview

This page describes the steps to build and run basic example for SHARC+ on ADSP-SC584 EZ-Kit
board using CrossCore Embedded Studio.

6.2.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.

Software Requirement

* Anaog Devices CrossCore Embedded Studio. For more information please refer to Software
environment set up for CrossCore Embedded Studio

® FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADSCP-SC584 EZ-Kit board
* AnICE1000 or ICE2000 emulator
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Connect the ICE1000 or ICE2000 emulator to DEBUG P1 port of EZ-Kit and the host PC using USB
cable and simultaneously connect the power supply with 12 volts as in the diagram below.

6.2.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Import the FreeRTOS example into CrossCore Embedded Studio:
® Select the File menu and then select the Import option from the menu
* When the Import project window appears:

® Click onthe General folder, then click on the Existing Projectsinto Wor kspace entry, and
click Next

® Click the Select root directory radio button and then click the Browse button

* Browse the root folder where you previously installed the FreeRTOS product and then browse
down into the FreeRTOSv10.0.0\FreeRTOS\Demo\SHARC_ADSP_SC584 CCESfolder

® Click Finish to close the file browser dialog

® Two projects should appear in the Project Explorer
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2 Irnport
Import Projects

Select a directory to search for existing Eclipse projects.

(1 Select archive file:

Projects:

@ Select root directony:  ChAnalog Devices\test_case\FreeRTOS\free -

Browse...

0
ﬁ}' g
L

Browse...

4 | 1

RTOSDemo_CCES_SHARC_Corel (Ch&nalog Dewvicesitest_case'Fn
RTOEDermo_CCES_SHARC Corel (ChAnalog Devices\test_casetfn

Options

[T]search for nested projects

[Tl Copy projects inta workspace

[T Hide projects that already exist in the workspace

Working sets

[(ladd project to working sets

i

Select All

Deselect All

Refresh

e, .

Select..,

Cancel

2. Choose Debug/Rel ease mode to build the project.

Edit Source Refactor Navigate Search P
E-f.'-'%{;m v Q-

roject Explorer Debug F=°
5 RTOSDemo_C v 2 Release |

& Binaries

mi Includes

& Debug

= FreeRTOS

& Include

= Release

& Source

Standard_Demo

-

3. Build the project in CrossCore Embedded Studio:
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* IntheProject Explorer right click onthe RTOSDemo CCES SHARC_Core0 and
RTOSDemo CCES SHARC_Corel project, then select the Build Project option from the

menu

6.2.4 Run the Example

Follow below five steps to do debug configuration, download and run the built binary on the target

board.

1. Inthe Project Explorer right click onthe RTOSDemo_CCES SHARC_Core0 project and select
the Debug As option from the menu

2. From the popup menu select Debug Configur ations option to create a new debug configuration
that matches your emulator and target board

File Edit Source
[mild | ®- |-Gt~ Qi 4]
[ Project Explorer £3

» [£§ » RTOSDemo_CCES_SHARC_Corel [freertos develoj
(5 » RTOSDemo_CCES_SHARC_Corel [freertos develo

Refactor MNavigate Search Project Run Window Help

7 Debug Cenfigurations

Create, manage, and tun configurations
@ You must select a debug session first

= x| B % -
type filter text

4 [ Application with CrossCore Debugger
1 RTOSDemo_CCES_SHARC_Corel) Debug
I Application with GDB and OpenOCD (Emulator)
1 Application with GDB and QEMU (Simulator)
> Lounch Group

Filter matched 5 of 10 items

@

7 Session Wizard

Select Processor
Choose a target processor.
Noi
| Processor family:
Processor type:

=

»

o [o =]

SHARC

<R ADSP-21584
<% ADSP-21587
< ADSP-SC570
< ADSP-SCST1
7 | % ADSP-sC572
<R ADSP-SC573
< ADSP-5C582
<R ADSP-SC583
<R ADSP-5C584
<R ADSP-SC587
<R ADSP-SC589

Select Session..

Options Silicon revision

Show all processors

7] Use selected project to create new session

@ Help

= Remove All..

Configurater.

Restore Defaults...
as..

3. Click the Debug button to close the Debug Configur ations window
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7 Debug Configurations ===

4 [ Application with CrossCore Debugger ErEmyE R
[ RTOSDemo_CCES_SHARC_Cored Debug
e Target: Emulation Debug Target
& Application with GDB and OpenQCD (Emulater) arget: Emulation Debug Torg
[ Application with GDB and QEMU (Simulatar) e A S E TSIy
i Launch Group Processor: ADSP-5C584

Create, manage, and run configurations E
Select a debug session te launch and a program to load
S X| B3P~ Name: RTOSDemo_CCES_SHARC_Cored Debug
type filter text ™% Session . ®g Automatic Breakpoints | [3 Target Options | 3¢ Custom Board Suppert| &3 Multiprocessor Groups | . Source| [] Commen

The following programi(s) will be loaded:

Progam optons Sicon eidon .

4 < Device0 [Core0]

[T C:\Analog Devices\CrossCore Embedded Studio 2.7.0\SHARC\IdriezkitSC584_p Reset, Run after load not available Ft.
] RTOSDemo_CCES_SHARC_Core0\Debug\RTOSDemo_CCES SHARC Cored  Check si-revision, Run after load not available Remove...
4 < Device0 [Corel]
] RTOSDemo_CCES_SHARC_Corel\Debug\RTOSDemo_CCES_SHARC_Corel.dxe Reset, Check si-revision, Run afterload 1.0
4 < DeviceO [Core2] Move Up
[T «Click here to select a program te load>
Move Down

Restore Defaults...

Save picture as...

Rever
@

4. Choose Core0 and click the Run/Resume button to start running Core0 application

Tuly &% dopueser sn E RN AV HIRE R
5 Debug 2

4 | RTOSDemo_CCES_SHARC Corel Debug [Application with CrossCore Debugger]
4 (i[9 ADSP-SC584 via ICE-1000
a4 f® Device0 [Core0] ( Cortex-A5 ) [Debug\RTOSDemo_CCES_SHARC Corel] (Suspended : Breakpoint)
2 Device0 [Corel] ( SHARC ) [Debug\RTOSDemo_CCES_SHARC_Corel.dxe] (Running : User Request)
2 Device 0 [Core 2] { SHARC ) (Running : User Request)

5. Then choose Corel and keep to click Run/Resume button to start running Corel application
i=<j' |umé%‘n|¢c§-‘7@ @R!-.";v-lﬁiliﬁluu ﬁv%v@@v - -

#5 Debug 52 ¥ = 0
a |l RTOSDemo_CCES SHARC_Corel Debug [Application with CrossCore Debugger]
a 2 ADSP-SC584 via ICE-1000

4 # Device [Core0] ( Cortex-A5 ) [Debug\RTOSDemo_CCES_SHARC_Corel] (Suspended : Breakpoint)
= <_exit>() at 089006628

4 ﬁeviceﬂ [Corel] (SHARC ) [Debug\RTOSDemo_CCES_SHARC_Corel.dxe] (Suspended : Ereakpoint)l
= main(int, char™*) at main.c:134 0l c21f4

& Device0 [Core 2] { SHARC ) (Running : User Request)

6.2.5 Test Results

Output from the application should be visible within the Console window in the CrossCore Embedded
Studio IDE. Y ou should see three LEDs on the EZ-Kit begin to flash. Test Passed will be printed if
the all tests passed.
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Output
Loading application: “C:\Analog Dewices\(rossCore Embedded Studio 2.7.@\SHARChldriezkits(584 prelcad_cored_wol”

Load cemplete.
Loading application: "C:%Analog Devices\freertos\FreeRTOSv1@. . @\FreeRTO5Demo\ SHARC_ADSP_SCS84 CCES\RTOSDemo_CCES_SHARC_Core@lDebughRTOSDemo_CCES_SHARC_Cored™

Load cemplete.
Loading application: "C:%Analog DevicesfreertosiFreeRTOSv1@. @, @4FreeRT05YDemo SHARC_ADSP_SCS584 CCESYRTOSDemo _CCES_SHARC Corel’DebughRTOSDemo_CCES_SHARC_Corel. dxe"

6.3 Running the LwIP Example for ARM on ADSP-SC584 EZ-Kit with
CrossCore Embedded Studio

6.3.1 Overview

This page describes the steps to build and run the LwlP Example for ARM on ADSP-SC584 EZ-Kit
with CrossCore Embedded Studio.

6.3.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.

Software Requirement

® Analog Devices CrossCore Embedded Studio. For more information please refer to Software
environment set up for CrossCore Embedded Studio

* FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADSCP-SC584 EZ-Kit board
* An|CE1000 or ICE2000 emulator

Connect the ICE1000 or ICE2000 emulator to DEBUG P1 port of EZ-Kit and the host PC using USB
cable, connect the target board to the same LAN as PC using standard network cable and
simultaneously connect the power supply with 12 volts as in the diagram below.

If connect SC584 to the same LAN as PC with 1000M switch, the SC584 EZ-Kit board in silicon 0.1
can't work with LwlP Example.
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USB TO PC

6.3.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Import the FreeRTOS example into CrossCore Embedded Studio:
* Select the File menu and then select the Import option from the menu

® Click onthe General folder, then click on the Existing Projectsinto Workspace entry, and
click Next

* Click the Select root directory radio button and then click the Browse button
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* Browse the root folder where you previoudly installed the FreeRTOS product and then browse

down into the FreeRTOSv10.0.0

\FreeRTOS\Demo\CORTEX_A5 ADSP_SC584 CCES LwlP folder

® Click Finish to close thefile browser dialog

® A single project should appear in the proj ects pane of the Import window

® Check the entry in the projects pane and click Import

27 Import

Import Projects

Select a directory to search for existing Eclipse projects,

o || B | ER
=
-

@ Select root directory:  Chfinalog Devicesifreertos\FreeRTOS:10.0.0 - Browse...

Select archiwve file:

Projects:

Browse...

4 UL

| DnsClient_FreeRTOS AL (Chanalog Devices\freertoshFreeRTO Sl

Select Al
Deselect Al
Fefresh

Options
Search for nested projects
Copy projects into workspace

Hide projects that already existin the workspace
Wlarking sets

Add project to working sets

Mewy,..

Zelect,,,

@ pes | [ Finish

+ Back

] | Cancel

2. Choose Debug/Release mode to build the project.
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Edit Source Refactor MNavigate Search Pro

LR Ll

roject Explorer "1 Debug [F==n
5 RTOSDemo. ¢ v .2 Release

£ Binaries

il Includes

& Debug

2= FreeRTOS

= Include

= Release
& Source
= Standard_Demo

= Quctam

3. Build the project in CrossCore Embedded Studio:

* IntheProject Explorer right click on the DnsClient_ FreeRTOS A5 project and select the
Build Project option from the menu

6.3.4 Run the Example

The semihosting I/0O mechanism, which writes to the CCES consol e during debug sessions, uses SWI
interrupts. Thisisincompatible with default GCC-compiled I/O code which also uses SWI interrupts.
For this reason, stdio function callsinitiated on the ARM core are routed out over UART instead and
shall be read with a serial terminal external to CCES. Importantly, note that:

1. Thisiscurrently only supported within FreeRTOS threads, any stdio function call performed
outwith athread will crash the application.

2. If you need to use other peripherals, you should take care not to change the power service clock
rate (which is set in the UART 1/O device.)

Before running the example, you need to setup the serial terminal of your choice to read the Cortex
core output from the UART to USB connection on the HOST PC. The easiest way to determine the
correct USB device isto view the Ports entry in the Windows Device Manager. From here identify
the COM port. Configure your serial console application to connect to the port with a baud rate of
115,200.
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=h Dewvice Manager
File Wiew  Help

= | E H= &

a2 GPAM2-D01
M Computer

=N R 5

Action

;l_fll' CrossCore Toals
g Disk drives
‘B Dizplay adapthers

-7 Human Interface Devices

g IDE ATASATAPL contrallers

<= Keyboards

}E!, Mice and other pointing dewvices
) Monitors

-F Metwork adapters

-7 Other devices

T Ports (COM & LPT

7 Communications Part (COMIL)
! =" USB Serial Port (COM25)

b I Pracessars

-3y Sound, video and game controllers
b M Systern devices

L N PRV P [ = PP e e | e

m

2 PUTTY Configuration @
Categony:
- Seszion B azic options for wour PUTTY session
P L.oggmg Specify the destination wou want to connect ba
=) Terminal S erial Speed
. Kevboard erial line pEE
- Bl COM25 115200
- Features Connection type:
= Window VRaw () Telmet ) Rlogin O 55H @ Serial
)
ppea_ranc:e Load, save or delete a stored seszion
- Behawviour
- Translation Saved Sessions
- Selection SCRE4_EZ LIART
- Colours :
Default Settings
= Connection = LA @]
- Pramy
- Rlogin
- 55H
- Serial Close window on exit:
) Alvays I Mever @ Only on clean exit
[ About l [ Help l [ Open ] [ LCancel ]

Follow below five stepsto do debug configuration, download and run the built binary on the target

board.

1. Inthe Project Explorer right click on the DnsClient_FreeRTOS_A5 project and select the Debug

As option from the menu

2. From the popup menu select Debug Configur ations option to create a new debug configuration

that matches your emulator and target board

7 Debug Configurations

Create, manage, and run configurations

[=

-
€3 You must select a debug session first 27 Session Wizard

Select Processor
EIEED

type filter text

Na|  Choose a target processor.

4 [ Application with CrossCore Debugger Processor family:

SHARC

I DnsClient_FreeRTOS_AS Debug Processor type:

I Application with GDB and Open0CD (Emulator)
I Application with GDE and QEMU (Simulator]
& Launch Group

< ADSP-21584
< ADSP-21587
<& ADSP-SC570
% ADSP-SC571
< ADSP-5C572
< ADSP-SC573
% ADSP-5C582
< ADSP-5C583
< ADSP-SC584
< ADSP-SC587
< ADSP-5C589

]

[ Show all processors

Use selected project to create new session

Configurator...

Next > Finish

&

or Groups | &~ Source | [£] Common

Select Session...

Options Silicon revision Add..
Edit...
Remove..
Move Up

Move Down

Restore Defaults...

Filter matched 5 of 11 items

3. Disable the semihosting function in Automatic Breakpoints
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7 Debug Configurations

Create, manage, and run configurations

X BB~

g
type filter text

4 [ Application with CrossCore Debugger
1 DnsClient_FreeRTOS_AS Debug
1 £pplication with GDB and OpenOCD (Emulator)
1 Application with GDB and GEMU (Simulator)
A Launch Group
i Launch Group (Deprecated)

Filter ratched 6 of 8 iterns

)
@

Specify and launch 3 CrassCore Embedded Studio program

Narne: DnsClient FreeRTOS A5 Debug

™% Session | 9 Autornatic Breakpoints [y Target Options |48 Custom Board Support| £3 Multiprocessor Groups | B Source| =] Common

Processor:

[Device 0 [Core 0] ¢ Cortexcs )

Breakpoints to set automatically after load:

Label Description
. Edit..
[}
[ ] Delete...
. Delete All,
. eletz Al
[}

[ClEnable semihosing

Rewert Bpply

4. Click the Debug button to close the Debug Configurations window

7 Debug Configurations

Create, manage, and run configurations

Select a debug session to launch and a program to load

type filter text

4 [ Application with CrossCore Debugger
L DnsClient_FreeRTOS_AS5 Debug
4 Application with GDB and OpenOCD (Emulater)
I Application with GDB and QEMU (Simulator)
 Launch Group

Filter matched 5 of 11 items

Gy
@

MName: DnsClient_FreeRTQS_AS Debug

[

=B Session 9 Automatic Breakpoints| [ Target Options | if Custom Board Support| & Multiprocessor Groups | & Source| ] Common

Session cenfiguration

Target: Emulation Debug Target
Platform: ADSP-SC584 via ICE-1000
Processor: ADSP-5C584

The fallowing program(s) will be loaded:
Pragram
4 < Device 0 [Core0]
[7] C\Analag Devices\CrossCore Embedded Studio 2.7.0\SHARC\Idr\ezkitSC584_prele Reset, Run after load
[ DnsClient_FreeRTOS_A5\Debug\DnsClient_FreeRTOS_AS
a & Device0[Corel]
[ =Click here to select a program to load>
a < Device0[Core2]

[] «Click here to select a program to load>

Options Silicon revision

not available
Check si-revision, Run after load  not available

T

5. Click the Run/Resume button to start running your application
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Remove...

Remove All...

Move Up

Move Down

Restore Defaults...
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File Edit Source Refactor Mavigate Search Project Target Run Window Help

="" - = \‘!} k§"m [ 4 ~\-3 {5:\ - i% - IE .J.:. - -

LT T

%5 Debug 52
4 | DnsClient_FreeRTOS_AS Debug [Application with CrossCore Debugger]
4 (12 ADSP-5C584 via ICE-1000
4 f# Device [Core0] [ Cortex-AS ) [Debug'DnsClient_FreeRTOS_A5] (Suspended : Breakpoint)
= main(] at app_main.c:79 08940316
p# Device O [Corel] ( SHARC ) (Running : User Request)
p# Device 0 [Core 2] ( SHARC ) (Running : User Request)

6.3.5 Test Results

Output from the application should be visible within the TTY terminal (e.g. PUTTY/TeralTerm). You
should seelink is established, and |P ADDRESS assigned from DHCP server will be printed after

you install the LwIP.

Qoo ,

itches for the ethernet
-~ need to set the MAC address in : . stored on b

Tzing temporary MAC: Ox0012345 =i
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7 Running the Examples on the ADSP-SC573 EZ-Kit

The FreeRTOS product for Analog Devices processors contains the following examples:

Processor Core Toolchain Example(s)

ADSP-SC573 ARM A5  CrossCore Embedded Studio  Basic Demo
ADSP-SC573 ARM A5  CrossCore Embedded Studio  Lwip Demo

ADSP-SC573 SHARC+  CrossCore Embedded Studio Basic Demo

The basic demo example is based on the Standard Demo Tasks that FreeRTOS recommend are
provided for each port of the FreeRTOS Operating System.

For more information on the Standard Demo Tasks please refer to http://www.freertos.org/a00013.
html.

The tasks performed in the Analog Devices Basic Demo include:
* LED flash
* Polled queue tasks
* Recursive Mutex tasks
* Blocking Queue tasks
e Statically allocated tasks
® Suicidal tasks

7.1 Running the Basic Example for ARM on ADSP-SC573 EZ-Kit with
CrossCore Embedded Studio

7.1.1 Overview

This page describes the steps to build and run basic example for ARM on ADSP-SC573 EZ-Kit board
using CrossCore Embedded Studio.

7.1.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.
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Software Requirement

* Anaog Devices CrossCore Embedded Studio. For more information please refer to Software
environment set up for CrossCore Embedded Studio

® FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADSCP-SC573 EZ-Kit board
* AnICE1000 or ICE2000 emulator

Connect the ICE1000 or ICE2000 emulator to DEBUG P1 port of EZ-Kit and the host PC using USB
cable and simultaneously connect the power supply with 12 volts as in the diagram below.

USB TO PC
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7.1.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Import the FreeRTOS example into CrossCore Embedded Studio:
® Select the File menu and then select the Import option from the menu

* Click onthe General folder, then click on the Existing Projectsinto Workspace entry, and
click Next

® Click the Select root directory radio button and then click the Br owse button

* Browse the root folder where you previously installed the FreeRTOS product and then browse
down into the FreeRT OSv10.0.0\FreeRTOS\Demo\CORTEX_A5 ADSP_SC573 CCES
folder

® Click Finish to close the file browser dialog
® A single project should appear in the projects pane of the Import window

® Check the entry in the projects pane and click Import
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#T Import
Import Projects

Select a directory to search for existing Eclipse projects.

]
n 8
I U

@) Select root directory: C\Analog Devices\test_case\freertos\FreeRTOSv10. + Browse...
() Select archive file: v Browse...
Projects:

RTOSDemo_CCES_Corel (ChAnalog Devices\test_case\freertos\FreeRTOS Select All

Deselect All

Refresh

i1

< | il P

Options

[ Search for nested projects

["] Copy projects into workspace

[ Hide projects that already exist in the workspace

Working sets
[ Add project to working sets MNew...

Working sets: hd Select...

® Next = [ Finish ] l Cancel

2. Choose Debug/Rel ease mode to build the project.
Edit Source Refactor Navigate Search P
E*:"%Tu:e t}'q'

roject Explorer 1 Debug | = 0
5 RTOSDemo_( v 2 Release

¥ Binaries

e Indludes

& Debug

= FreeRTOS

&= Include

& Release

& Source

Standard_Demo

Fiabama

3. Build the project in CrossCore Embedded Studio:

® IntheProject Explorer right click onthe RTOSDemo_CCES Core0 project and select the
Build Project option from the menu
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7.1.4 Run the Example

The semihosting I/0O mechanism, which writes to the CCES consol e during debug sessions, uses SWI
interrupts. Thisisincompatible with default GCC-compiled I/O code which also uses SWI interrupts.
For this reason, stdio function callsinitiated on the ARM core are routed out over UART instead and
shall be read with a serial terminal external to CCES. Importantly, note that:

1. Thisiscurrently only supported within FreeRTOS threads, any stdio function call performed
outwith athread will crash the application.

2. If you need to use other peripherals, you should take care not to change the power service clock
rate (which is set in the UART 1/O device).

Before running the example, you need to setup the serial terminal of your choice to read the Cortex
core output from the UART to USB connection on the HOST PC. The easiest way to determine the
correct USB device isto view the Ports entry in the Windows Device Manager. From here identify

the COM port. Configure your seria console application to connect to the port with a baud rate of
115,200.

=1 Device hManager EI@ ﬁ PuTTY Canfiguration @
File  Action  “iew Help Categony:
<‘,E| IE:} | = | D | E s | e | =y :& :p‘, - S_ession Bazic options for your PuTTY session
i L_Dgglng Specify the destination you want bo contect to
4= GPANZ-D01 =J- Terminal .
g ; Senal lipe Speed
y 'L Cgmputer - Kewboard
- . . el CamMzz2 115200
s Disk drives Fot - P
. B Displav adant - Features onnection e
m Dy adapters e window Raw () Telnst ) Rlogin () S5H @ Serial
--M5 Hurnan Interface Devices - Appeatance
g IDE ATASATAPI controllers - Behaviour Load, save or delete & stored zession
2 Keyboards - Translation Saved Sessions
-4 Mice and other pointing devices - Selection SCA73_EZ_UART
o Monitors - Colours ;
b= " Default Settings Load
5._:1- Metwork adapters —J- Connection SC573 EZ UART I_—/
o) Other devices E:;:y I—/SE'EB
a7 Ports (COM & LPT)
T Delet
- 213 Communications Port (CORI ;TDI";: Iﬂ/
LIS USE Serial Part (COM22) +- S5H
. ) Processars o Gerial ) .
b % Sound, video and game caontrollers Close window on e
. ) ’ . Always Newver @ Only on clean exit
M Systern devices
»- i Universal Serial Bus contrallers
| About | | Help | [ Open ] | LCancel |

After this, follow the steps below to do debug configuration, download and run the built binary on the
target board.

1. Inthe Project Explorer right click on the RTOSDemo_CCES Cor €0 project and select the
Debug As option from the menu

2. From the popup menu select Debug Configur ations option to create a new debug configuration
that matches your emulator and target board
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7 Debug Configurations @

Create, manage, and run configurations o

Select a debug session to launch and a program to load

- -,

CEX B3>~ Mame: RTOSDemo_CCES Corel Debug

type filter text B Session % Automatic Breakpoints | [33 Target Options | #§ Custom Board Support| & Multiprocessor Groups| & Source | ] Common|
a | Application with CrossCore Debugger Session configuration

L4 RTOSDemo_CCES_Cored Debug

Target: Emulation Debug Target
4 Application with GDB and OpenOCD (Emul e ”? — Select Session
4 Application with GDE and QEMU (Simulate Platform: ADSP-5C573 via ICE-1000
@ Launch Group Processor: ADSP-SC573

The following program(s) will be loaded:

Program Options Silicon revision _

4 3 Device0 [Core0]
[7] C:\Analog Devices\CrossCore Embedded Studio 2.7.00SHARC\Idrt Reset, Run after load not available
[7] RTOSDemo_CCES Cored'\Debug\RTOSDemo CCES_Cored Check si-revision, Run after load  not available Remove...
a4 3 Device0[Corel]
[T] <Click here to select a program to load=
4 <@ Devicel [Core 2]
7] <Click here to select a program to load>

Edit...

Move Up

Move Down

Restore Defaults...

< 1 [3
Revert Apph
Filter matched 5 of 8 items l SVl ] l PEY ]

@ [ Debug i [ Close l

3. Disable the semihosting function in Automatic Breakpoints

r
7 Debug Configurations

Create, ge, and run fig

Specify and launch a CrossCore Embedded Studic program

1
x | S Name: RTOSDemo_CCES Corel Debug
% Session | % Automatic Breakpoints . [ Target Optlonq Bﬁ Custom Board SUpporﬂ £ Multiprocessor Groups} 73 SDUI'CEW i=] gommorq
4 Application with CrossCore Debugger Processorn
¥} R.TOEI-Demn_CCES_CDreﬂ Debug [DE\'ICEU [Care0] { Cortex-A5 ) ‘]
4 Application with GDB and OpenOCD (Emulator) I
fl i Application with GDB and QEMU (Simulator) Breakpoints to set automatically after load: |
@ Launch Group Description New... I
B Launch Group (Deprecated) Il
Edit...
Delete... N
I
Delete All... Il
i
i
i
I
I
i
i
i
[l Enable semihosting i
< m v i
. 3 Revert Apply
Filter matched 6 of 6 items M
i
® Debug ] [ Close

4. Click the Debug button to close the Debug Configur ations window
5. Click the Run/Resume button to start running your application
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Eile Edit 5Source Refactor Navigate Search Target Preoject Run  Window Help
A B - i dS OB R|SM 3 B AN RIS =l T
%5 Debug &2
a [ RTOSDemo_CCES_Cored Debug [Application with CrossCore Debugger]
4 [ ADSP-5C573 via ICE-1000
4 f® Device0 [Core0] ( Cortex-AS5 ) [Debugh\RTOSDemo_CCES_Corel] (Suspended : Breakpoint)
= main(int, char*™) at main.c:133 0x39014%a

& Device0 [Corel] ( SHARC ) (Running : User Request)
u& Device 0 [Core 2] ( SHARC ) (Running : User Request)

7.1.5 Test Results

Output from the application should be visible withinthe TTY terminal (e.g. PUTTY/TeralTerm). You
should see the LEDs on the EZ-Kit begin to flash. Test Passed will be printed if al the tests passed.

7.2 Running the Basic Example for SHARC+ on ADSP-SC573 EZ-Kit with
CrossCore Embedded Studio

7.2.1 Overview

This page describes the steps to build and run basic example for SHARC+ on ADSP-SC573 EZ-Kit
board using CrossCore Embedded Studio.

7.2.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.

Software Requirement

® Analog Devices CrossCore Embedded Studio. For more information please refer to Software
environment set up for CrossCore Embedded Studio

® FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADSCP-SC573 EZ-Kit board
* AnICE1000 or ICE2000 emulator

Connect the ICE1000 or ICE2000 emulator to DEBUG P1 port of EZ-Kit and the host PC using USB
cable and simultaneously connect the power supply with 12 volts as in the diagram below.
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USB TO PC

7.2.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Import the FreeRTOS example into CrossCore Embedded Studio:
® Select the File menu and then select the Import option from the menu
® When the Import project window appears:

® Click onthe General folder, then click on the Existing Projectsinto Workspace entry, and
click Next

® Click the Select root directory radio button and then click the Browse button

* Browse the root folder where you previoudly installed the FreeRTOS product and then browse
down into the FreeRTOSv10.0.0\FreeRTOS\Demo\SHARC_ADSP_SC573 CCESfolder

® Click Finish to close the file browser dialog

® Two projects should appear in the Project Explorer
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2 Irnport

Import Projects

Select a directory to search for existing Eclipse projects.

(1 Select archive file:

Projects:

@ Select root directony:  ChAnalog Devices\test_case\FreeRTOS\free -

Browse...

0
ﬁ}' g
L

Browse...

4 | 1

RTOSDemo_CCES_SHARC_Corel (Ch&nalog Dewvicesitest_case'Fn
RTOEDermo_CCES_SHARC Corel (ChAnalog Devices\test_casetfn

Options

[T]search for nested projects

[Tl Copy projects inta workspace

[T Hide projects that already exist in the workspace

Working sets

[(ladd project to working sets

Select All

Deselect All

i

Refresh

e, .

Select..,

Cancel

2. Choose Debug/Rel ease mode to build the project.

Edit Source Refactor Navigate Search P
ﬁ‘:-‘"%{;m b'%'

mecbpoer, (0% o0
5 RTOSDemo_¢ v 2 Release |

& Binaries

et Includes

& Debug

= FreeRTOS

= Include

= Release

& Source

Standard_Demo

-

3. Build the project in CrossCore Embedded Studio:
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* IntheProject Explorer right click onthe RTOSDemo CCES SHARC_Core0 and
RTOSDemo CCES SHARC_Corel project, then select the Build Project option from the
menu

7.2.4 Run the Example

Follow below five steps to do debug configuration, download and run the built binary on the target
board.

1. Inthe Project Explorer right click onthe RTOSDemo_CCES SHARC_Core0 project and select
the Debug As option from the menu

2. From the popup menu select Debug Configur ations option to create a new debug configuration
that matches your emulator and target board

7 .
e e 7 Session Wizard = || ]

Create, and run

Select Processor

€3 You must select a debug session first Choose a target processor.

2 B iy -

= X | = Name: RTOSD  processor family: SHARC -
type filter text 3 Session Processor type: Seurce| ] Cemmen
a [ Application with CrossCore Debugger Session confi < ADSP-21584 i

3 RTOSDemo_CCES_ SHARC_Corel Debug
I3 Application with GDB and OpenOCD (Emulator)
Id Application with GDB and QEMU (Simulator)
# Launch Group Processor: N

Target: Nong | | < ADSP-21587 |
Platform: Nd | |  ADSP-5C570
4 ADSP-SCSTL
@ ADSP-SC5T2
The following “* ADSP-SC573
Program @ ADSP-5C582 Options Silicon revision

4 ADSP-SC583
< ADSP-5C5E4
@ ADSP-SC5E7
< ADSP-5C58

Show all processors

7] Use selected project to create new session

Configurator...
@ Help < Bac Next > Fmer —

Revert
Filter matched 5 of 10 items

@

&

3. Click the Debug button to close the Debug Configur ations window
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7 Debug Configurations

Create, manage, and run configurations

Select a debug session to launch and a program to lead

EIEE
type filter text
4 4 Application with CrossCare Debugger
Ll RTOSDemo_CCES_SHARC_Cored Debug
I3 Application with GDB and Open0CD (Emulator)
I3 Application with GDB and QEMU (Simulator)
& Launch Group

Filter matched 5 of 10 items

)
@

Name: RTOSDemo_CCES_SHARC_Corel Debug

T

™% Session . ® Automatic Breakpoints | [ Target Options | v5 Custom Board Support| §i Multiprocessor Groups | 1+ Source| [] Common

Session configuration

Target: Emulation Debug Target
Platform: ADSP-SC573 via ICE-1000

Processor: ADSP-5C573

The following program(s) will be loaded:

Program
4 4 DeviceO [Core0]

Options

[ C:\Analog Devices\CrossCore Embedded Studio 2.7.0\SHARC\Idr\ezkitST573_pre Reset, Run after load
[] RTOSDemo_CCES_SHARC_Core0\Debug\RTOSDemo_CCES_SHARC_Cored Check si-revision, Run after load

4 < Device [Corel]

[] RTOSDemo_CTES_SHARC_Corel'\Debug\RTOSDemo_CCES_SHARC_Corel.dxe  Reset, Check si-revision, Run after load

4 < Device0 [Core2]

[7] <Click here to select a program to load>

i

Silicon revision

not available
not available

0.0

4. Choose Core0 and click the Run/Resume button to start running Core0 application

File Edit Source Refactor Mavigate

i | B i

5 Debug 2

Search Project Target FRun

.1'01'n| é é—{)¢? S o -lr‘f| {‘3 i

Window Help

A Qi@ P A -

a |4 RTOSDemo_CCES_SHARC_Corel Debug [Application with CrossCore Debugger]

4 2 ADSP-5C573 via ICE-1000

[eiey

4 f# Device0 [Core 0] ( Cortex-AS ) [nguq\RTOSDemo CCES SHARC Corel] (Suspended : Breakpeint)

= m_ain{] at RTOSDemo CCES SHARC Corel.c:17 0x89004f9c

& Device 0 [Core1] ( SHARC ] [Debug\RTOSDemo_CCES_SHARC_Corel.dxe] (Running : User Request)
o8 Device 0 [Core 2] ( SHARC ) (Running : User Request)

oo

==

e

Edit...

Remove...

Remove All...

Move Up

Move Down

Restore Defaults...

[ [
(o) oo

5. Then choose Corel and keep to click Run/Resume button to start running Corel application

File Edit Source Refactor MNavigate

d | nmf%ﬁ

gy
|

%5 Debug 52

Search Project Target Run

o] ®z e

& m

Window Help

FRCRIr PR HOE

4 | RTOSDemo_CCES_SHARC_Cored Debug [Application with CrossCore Debugger]

4 2 ADSP-SC573 via ICE-1000

[

& Device 0 [Core 0] { Cortex-A5 ) [Debug\RTOSDemo_CCES_SHARC_Corel] (Running : User Request)

{w"‘—‘ Device 0 [Corel] ( SHARC ) [Debug\RTOSDemeo_CCES_SHARC Corel.dxe] (Suspended : Breakpoint) |

= main(int, char™) at main.c:134 0x1c22%e
32 Device 0 [Core 2] ( SHARC ) (Running : User Request)

7.2.5 Test Results

& -

Output from the application should be visible within the Console window in the CrossCore Embedded
Studio IDE. Y ou should see three LEDs on the EZ-Kit begin to flash. Test Passed will be printed if

the all tests passed.
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& Consale 22 &) Tasks| [ Problems| €3 Executables | G Debugger Console

Qutput

Loading application: "C:%Analog Devices‘(rossCore Embedded Studio 2.7.@4\SHARCA\1ldriezkitSC(573_preload_coree”

Lead complete.

Loading application: "C:\Analog Devices\freertos\FreeRTO5v1@.@. @\FreeRTOS)DemolSHARC_ADSP_SCS573 CCESYRTOSDemo CCES_SHARC Cored\DebughRTOSDemo_CCES_SHARC Core@™

-
o

d
oading application: “C:VAnalog Devices\freertos\FreeRTO5v1@.@.@84FreeRTOS)DemolSHARC_ADSP_SCS573_CCESVRTOSDemo CCES_SHARC_Corel\DebughRTOSDemo_CCES_SHARC Corel. dxe"
d

[

mo
n
n

-
@
in
n
m
a

7.3 Running the LwIP Example for ARM on ADSP-SC573 EZ-Kit with
CrossCore Embedded Studio

7.3.1 Overview

This page describes the steps to build and run the LwIP Example for ARM on ADSP-SC573 EZ-Kiit
with CrossCore Embedded Studio.

7.3.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.

Software Requirement

® Analog Devices CrossCore Embedded Studio. For more information please refer to Software
environment set up for CrossCore Embedded Studio

* FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADSCP-SC573 EZ-Kit board
* AnICE1000 or ICE2000 emulator

Connect the ICE1000 or ICE2000 emulator to DEBUG P1 port of EZ-Kit and the host PC using USB
cable, connect the target board to the same LAN as PC using standard network cable and
simultaneously connect the power supply with 12 volts as in the diagram below.
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7.3.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Import the FreeRTOS example into CrossCore Embedded Studio:
* Select the File menu and then select the Import option from the menu
* When the Import project window appears.

® Click onthe General folder, then click on the Existing Projectsinto Workspace entry, and
click Next

® Click the Select root directory radio button and then click the Browse button
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* Browse the root folder where you previously installed the FreeRTOS product and then browse
down into the FreeRTOSv10.0.0
\FreeRTOS\Demo\CORTEX_A5 ADSP_SC573 CCES_LwIP folder

® Click Finish to close the file browser dialog
® A single project should appear in the Project Explorer

#7 Import = || =] 28
Imponrt Projects —
Select a directory to search for existing Eclipse projects, / ,n";
-

@ Select root directory:  Chdinalog Deviceshfreertos\FreeRTOS10.0.0 - Browse...

Select archive file: Browise...

Projects:

| DnsClient_FreeRTOE_A5 (Chanalog Devices\freertoshFreeRTO 5wl Select Al

Deselect Al
Refresh

4 1 3

Options
Search for nested projects
Copy projects into workspace

Hide projects that already exist in the workspace
Wlarking sets
Add project to weorking sets Mews,.,

Select,.,

'/?3' < Back Mext = [ Finish ] | Cancel

2. Choose Debug/Rel ease mode to build the project.
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Edit Source Refactor Navigate Search P

R T v Qv
ila Debug = A
v 2 Release

roject Explorer
5 RTOSDemo_C
" Binaries
i Includes
& Debug
FreeRTOS
Include
Release
Source
Standard_Demo

-

3. Build the project in CrossCore Embedded Studio:

® IntheProject Explorer right click on the DnsClient_FreeRTOS_AS5 project and select the
Build Project option from the menu

7.3.4 Run the Example

The semihosting 1/0 mechanism, which writes to the CCES console during debug sessions, uses SWI
interrupts. Thisisincompatible with default GCC-compiled I/O code which also uses SWI interrupts.
For this reason, stdio function callsinitiated on the ARM core are routed out over UART instead and
shall be read with a serial terminal external to CCES. Importantly, note that:

1. Thisiscurrently only supported within FreeRTOS threads, any stdio function call performed
out with athread will crash the application.

2. If you need to use other peripherals, you should take care not to change the power service clock
rate (which is set in the UART 1/O device).

Before running the example, you need to setup the serial terminal of your choice to read the Cortex
core output from the UART to USB connection on the HOST PC. The easiest way to determine the
correct USB deviceisto view the Ports entry in the Windows Device Manager. From here identify
the COM port. Configure your serial console application to connect to the port with a baud rate of
115,200.
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File Wiew  Help
&= T E H=Z " ERS

a2 GPAM2-D01
> M Computer

Action

b e Disk drives

- B Display adapters
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b -F Metwork adapters
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157 USE Serial Port (COM22)
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b -4y Sound, video and garne controllers
oM Systern devices
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—J- Terminal Cerial Speed
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- Features Connection type:
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e

ppea.rance Load, save or delete a stored session
- Behaviour
- Translation Saved Sessions
. Selection SCAY3 EZ UART
- Colours :
Default Settings
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|

Follow below five steps to do debug configuration, download and run the built binary on the target

board.

1. Inthe Project Explorer right click on the DnsClient_FreeRTOS A5 project and select the Debug

As option from the menu

2. From the popup menu select Debug Configur ations option to create a new debug configuration

that matches your emulator and target board
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27 Debug Configurations

Create, manage, and run configurations

€ You must select a debug session first

e

type filter text

a I Application with CrossCore Debugger
u DnsClient_FreeRTOS 45 Debug

I Application with GDB and QpenOCD (Ernulat

& Application with GDB and QEMU (Simulator)
B Launch Group

1 [ r

Filter matched 3 of 11iterns

P
@

7 Session Wizard

Select Processor

MName: Choose a target processor,

e

Sessi
Tard Processor type:

Processor family:

SHARC

Play | S ADSP-21564
Proj | 4 ADSP-21547
& ADSP-SC5T0
The{ | <@ ADSP-SCSTL

Pro | S ADSP-SCST2
& ADSP-SC5T3
G ADSP-SC562
< ADSP-SC583
G ADSP-SCH84
& ADSP-SC58T
& ADSP-SC569

[l Show all processors

@

=< Back

[#] Use selected project to create new session

3. Disable the semihosting function in Automatic Breakpoints

£

roups | % Source | [ Common

Select Sessian...

Silicon revision Add...
Edit...

Remowe...

Remave All..,

Move Up

Mowve Down

Restore Defaults..,

7 Debug Configurations

Create, manage, and run configurations

Specify and launch 3 CrossCore Embedded Studio program

X IR
type filter text
4 [ Application with CrossCare Debugger
[ DnsClient FreeRTOS A5 Debug
[ Application with GDE and Open0CD Emulstor)
I 2pplication with GDB and QEML (Simulator)
. Launch Group
I Launch Group (Deprecated)

Filter matched & of 8 iterns

Name: DnsClient_FreeRTO3_AS Debug

=M Session |9 Automatic Breakpaints

Processon

(3 Target Dptions

i

34 Custom Board Suppart| €3 Muttiprocessor Groups | B Source| ] Comman

[Device 0 [Care 01 ¢ Cortexts)

Breakpaints to set automatically after load:

Label Description
[ ]

Mew,
Edit..
Delete..

Delete Al..

[TIErabie serminosting:

Revert Apply

4. Click the Debug button to close the Debug Configur ations window
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7 Debug Configurations ==

Create, . ahd run confi ions 5
Select a debug session ta launch and a program ta load J

EIEED Marne: DnsClient_FreeRTOS_A5 Debug
type filter et Session . ®g Autornatic Breakpoints Target Options | 0 Customn Board Support| €8 Multiprocessor Groups | B Source| B Common
P GERR -] pport| & P P3| 5
4 u Application with CrossCore Debugger Session configuration
Ll DnsClient_FreeRTOS A5 Debug S
= = Target: Ermulation Debug T t
& Zpplication with GDB and OpenQCD (Ernulat IR RN u? g Select Session...
@ Application with GDE and QEMU (Simulatar) (Mt AU i ICE-H010
I Launch Sroup Processor ADSP-3C573
The fallowing program(s) will be loaded:
Prograrm Options Silican rewision Add...
4 & Dewvice 0 [Care 0] Edit
[] CAAnalog Devices\CrossCore Embedded Studio 2.7.045HARCA driezkit Reset, Run after load not available
[] DnsCliert_FreeRTOS_AS\Debug'DnsClient_FreeRTOS_AS Check si-revision, Run after load ot available Remove...
4 < Device 0 [Core 1] —
[ <Click here to select 3 pragram to load > Remaowve All..
4 & Dewvice 0 [Care 2] Mo LI
[] <Click here to select a program to load > B
Move Down
Restare Defaults. .
) ' [ Revet [ appy |
H
Filter matched 5 of 11 items S HEL
'/?j' I Debug l I Close

5. Click the Run/Resume button to start running your application

File Edit Sowrce Refactor Mawigate Search  Target  Project Bun  Window Help
N Hol B éoRlussec/sanrit-Q-i®yigil-

#S Debug &2
4 | DnsClient_FreeRTOS A5 Debug [Application with CrossCore Debugger]
4 2 ADSP-SC573 wia ICE-1000
a of# Dewvice 0 [Care 0] { Cortex-25 ) [DebugDnsClient_FreeRTOS AS] (Suspended : Breakpoint)
| = main{) at app_main.c:79 039403162 |
o Device 0 [Core 1] { SHARC ) (Running : User Request)

o2 Device 0 [Core 2] { SHARC ) (Running : User Request)

7.3.5 Test Results

Output from the application should be visible withinthe TTY terminal (e.g. PUTTY/TeralTerm). You
should seelink is established, and I|P ADDRESS assigned from DHCP server will be printed after
you install the LwlIP.
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8 Running the Examples on the ADSP-BF7XX EZ-Kit

The FreeRTOS product for Analog Devices processors contains the following examples:

Processor Toolchain Example(s)

ADSP-BF707  CrossCore Embedded Studio Basic Demo

The basic demo example is based on the Standard Demo Tasks that FreeRTOS recommend are
provided for each port of the FreeRTOS Operating System.

For more information on the Standard Demo Tasks please refer to http://www.freertos.org/a00013.
html.

The tasks performed in the Analog Devices Basic Demo include:
* LED flash
* Polled queue tasks
* Recursive Mutex tasks
* Blocking Queue tasks
e Statically allocated tasks
® Suicidal tasks

8.1 Running the Basic Example for ADSP-BF707 EZ-Kit with CrossCore
Embedded Studio

8.1.1 Overview

This page describes the steps required to build and run basic example on ADSP-BF707 EZ-Kit board
using CrossCore Embedded Studio.

8.1.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.

Software Requirement
® Analog Devices CrossCore Embedded Studio. For more information please refer to Software

environment set up for CrossCore Embedded Studio
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* FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADSP-BF707 EZ-Kit board
* AnICE1000 or ICE2000 emulator

Connect the ICE1000 or ICE2000 emulator to DEBUG P3 port of EZ-Kit and the host PC using USB
cable and simultaneously connect the power supply with 5 volts asin the diagram below

=28
s
i
4

8.1.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Select the File menu and then select the Import option.

® Click onthe General folder, then click on the Existing Projectsinto Workspace entry, and
click Next

® Click the Select root directory radio button and then click the Browse button
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Browse the root folder where you previously installed the FreeRTOS product and then browse
down into the \FreeRT OSv10.0.0\FreeRTOS\Demo\Blackfin_ADSP_BF707_CCESfolder

Click OK to close the file browser dialog

A single project should appear in the proj ects pane of the Import window

® Check the entry in the proj ects pane and click Finish

B Import = @lél
Imponrt Projects e :
Select a directory to search for existing Eclipse projects, / ;.4
@) Select root directory: CE: IR Browwse..,
() Select archive file: Browvse..,
Projects:

RTOSDerno_BFTOT (ChAnalog Devices\freertashFreeRTOS 10,0000 Select All

Deselect All

Refresh

4 UL 2

Options

[7] Search for nested projects

[7] Copy projects inta workspace

[T1Hide projects that already exist in the workspace

Warking sets

[Tl add project to working sets Mew..,

Select...

':?;' Mext = [ Finish l [ Cancel

2. Choose Debug/Release mode to build the project.

File Edit Source Refactor Mavigate Search Project Run Window Help
ik B [&f Bit-Arioms IR TR R R

5 Project Explorer &2 0 G B

&l
q
i

]

3. Build the project in CrossCore Embedded Studio

* IntheProject Explorer right click on the RTOSDemo_BF707 project and select the Build
Proj ect option from the menu
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8.1.4 Run the Example

Follow below four steps to do debug configuration, download and run the built binary on the target
board.

1. Inthe Project Explorer right click onthe RTOSDemo BF707 project and select the Debug As
option from the menu

2. From the popup menu select Debug Configur ations option to create a new debug configuration
that matches your emulator and target board

7 Debug Configurations £

Create, and run i i - )
€3 You must select a debug session first J
- X | Era 7 Session Wizard = ==
2 ==

Select Processor
type filter text

essor Groups | % Source | [ Comman
Choose a target processor. =
4 @ Application with CrossCare Debugger
| RTOSDEmo_BFTO7 Debug N
I Application with GDB and OpenCD (Emulator) Processor family: Blackfin - Select Session..
I Application with GDB and QEMU (Sirmulator)
B Launch Group

Pracessortype:
% ADSP-BF607 -
% ADSP-BF608
% ADSP-BF600
% ADSP-BFT00
<& ADSP-BF701 Edit..
% ADSP-BFT02
% ADSP-BFT03
< ADSP-BFT04 Remove All..
% ADSP-BFT05
% ADSP-BFTIG Move Up
% ADSP-BFT07 Mawe Do

Show all processors Restore Defaults...
V] Use selected project to create new session
Configuratar..

@ Help < Back Fiateln Cancel

Options Silicon revisian Add...

Rernove...

. m 3

Rewvert Appl
Filter matched 5 of 12 iterns 3 PRl
@ Debug | [ Clase ]

3. Click the Debug button to close the Debug Configur ation window
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7 Debug Configurations

Create, and run confi i

Select a debug session to launch and & program to load @\‘
IR

Mame: RTOSDema_BFT0T Debug

4

4 @ Application with CrossCare Debugger
L RTOSDerno_BFTO7 Debug

= Session @ Automnatic Breakpoints | [ Target Options | 38 Custarn Board Support| & Multiprocessor Groups| % Source | [] Common
Session configuration

Target; Blackfin CS Emulat
& Application with GDB and Open0CD Emulator) arget Blackiin &> brmulator Select Session..
I3 Application with GDB and QEMU (Simulstor) Pl A0 G oo T2
B Launch Group Processor ADSP-BFT0T

The following programis) will be loaded:

Program Options Silicon revision Add...

] RTOSDermo_BFTOT\Debug \RTOSDerna_BFT0T dxe Reset, Check si-revision, Run after load — any

Edit...
Remowve..,
Rernawe &ll...
Mowve Up

Miowe Down

Restore Defaults...

] m

Filter matched 5 of 12 items

Revert Apphy

@

4. Click the Run/Resume button to start running your application
iR &% b oo ms = | 4R v Qv i
5 Debug 2

4 |l RTOSDerno_BFT07 Debug [Application with CrossCore Debugger]
4 12 ADSP-BFTOT

4 f® ADSP-BFT0T [Debug RTOSDemo_BFT07.dxe] (Suspended : Breakpoint)
= mainfint, char™) at main.c134 0:11a02F32

8.1.5 Test Results

Output from the application should be visible within the Console window in the CrossCore Embedded

Studio IDE. Y ou should see three LEDs on the EZ-Kit begin to flash. Test Passed will be printed if
the all tests passed.

Output

Loading application: "C:\dnaleg Deviceshfreertos\FreeRTOSw1@.d. @%FreeRTO5\DemohBlackfin_ADSP_EBF787_CCES\Debug\RTOSDemo BEF787. dxe"
Load complete.

Test passed
Test passed
Test passed
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9 Running the Examples on the ADSP-21569 EZ-Kit

The FreeRTOS product for Analog Devices processors contains the following examples:

Processor Toolchain Example(s)

ADSP-21569  CrossCore Embedded Studio Basic Demo

The basic demo example is based on the Standard Demo Tasks that FreeRTOS recommend are
provided for each port of the FreeRTOS Operating System.

For more information on the Standard Demo Tasks please refer to http://www.freertos.org/a00013.
html.

The tasks performed in the Analog Devices Basic Demo include:
* LED flash
* Polled queue tasks
* Recursive Mutex tasks
* Blocking Queue tasks
e Statically allocated tasks
® Suicidal tasks

9.1 Running the Basic Example for ADSP-21569 EZ-Kit with CrossCore
Embedded Studio

9.1.1 Overview

This page describes the steps required to build and run basic example on ADSP-21569 EZ-Kit board
using CrossCore Embedded Studio.

9.1.2 Environment Setup

Before running the basic example with CrossCore Embedded Studio, you should make some
preparation for environment setup including software and hardware.

Software Requirement
® Analog Devices CrossCore Embedded Studio. For more information please refer to Software

environment set up for CrossCore Embedded Studio
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* FreeRTOS product and the Analog Devices FreeRTOS product. For more inormation please
refer to Get the source code ready

Hardware Setup
* An ADSP-21569 EZ-Kit board
* AnICE1000 or ICE2000 emulator

Connect the ICE1000 or ICE2000 emulator to DEBUG P4 port of EZ-Kit and the host PC using USB
cable and simultaneously connect the power supply with 12 volts as in the diagram below

Lo 0.0 00

L

I\ b
B 1had
I8

9.1.3 Build the Example

Before you run the FreeRTOS example in CrossCore Embedded Studio, follow below three steps to
import and build it.

1. Select the File menu and then select the Import option.

® Click onthe General folder, then click on the Existing Projectsinto Workspace entry, and
click Next

® Click the Select root directory radio button and then click the Browse button

* Browse the root folder where you previoudly installed the FreeRTOS product and then browse

down into the FreeRTOSv10.0.0
\FreeRTOS\Demo\SHARC_ ADSP 21569 CCES\RTOSDemo CCES SHARC 21569
folder

® Click OK to closethefile browser dialog
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* A single project should appear in the proj ects pane of the Import window

® Check the entry in the proj ects pane and click Finish
2T Import = @
Import Projects B

Select a directory to search for existing Eclipse projects.

9 Select root directory: :C_ADSP_21569_CCES\RTOSDemo_CCES_SHARC_21569 ~ Browse...
Select archive file: - Browse

Projects:

| RTOSDemo_CCES_SHARC_21569 (C\Analog Devices\test_case\freertos-bitbuc Select All

Deselect All
Refresh

] [} »

Options
Search for nested projects
Copy projects into workspace

Hide projects that already exist in the workspace
Working sets

Add project to working sets New...

"'_“) < Back Next > l Finish ] | Cancel

2. Choose Debug/Rel ease mode to build the project.

File Edit Source Refactor Mavigate Search Project Run Window Help

ik s-[&f @itrariosy R IR R R

(3 Project Explorer &2 ==

&l
q
I

o

3. Build the project in CrossCore Embedded Studio

® IntheProject Explorer right click onthe RTOSDemo_CCES SHARC_21569 project and

select the Build Project option from the menu

9.1.4 Run the Example

Follow below four steps to do debug configuration, download and run the built binary on the target

board.

1. Inthe Project Explorer right click onthe RTOSDemo CCES SHARC 21569 project and select

the Debug As option from the menu
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2. From the popup menu select Debug Configur ations option to create a new debug configuration
that matches your emulator(ICE1000 or ICE2000) and target board

7 Debug Configurations

Create, manage, and run configuratid

— (=]
.7 Session Wizard = @ E\

Select Processor
@ You must select a debug session first

Choose a target processor.

2% B2~
type filter text 4 Processor family: SHARC '] rcel 1
< d Application with CrossCore Debug Processor type: ~
d RTOSDemo_CCES_SHARC_2156¢ A ADSP-21569 ~
i Application with GDB and OpenQC @ ADSP-21571 [t Session...
4 Application with GDB and QEMU (S @ ADSP-21573 |
& Launch Group @ ADSP-21583 L
¥ Launch Group (Deprecated) @ ADSP-21584
® ADSP-21587 El add
« ADSP-SC570 Edit
“ ADSP-SC571 h -
D Show all processors emove.
Use selected project to create new session hman | ™

4 L1 » Configurator...

Filter matched 6 of 8 items
@ Close

3. Click the Debug button to close the Debug Configur ations window

7 Debug Configurations @

Create, manage, and run configurations g\

Select a debug session to launch and a program to load

EIEE R
Name: RTOSDemo_CCES_SHARC_21569 Debug
type filter text

1010

"B Session . °s Automatic Breakpoints| B Target Options | *# Custom Board Support| % Multiprocessor Groups | % Source & Common
4 4 Application with CrossCore Debugg

Session configuration =
d RTOSDemo_CCES_SHARC_ 21569
@ Application with GDB and OpenOCT Target: Emulation Debug Target Select Session...
@ Application with GDB and QEMU (Si Platform: ADSP-21569 via ICE-1000
& Launch Group Processor: ADSP-21569

® Launch Group (Deprecated) The following program(s) will be loaded:

Program Options Silicon revision
O C\Analog Devices\CrossCore Embedded Studio Reset, Run after load any
1 RTOSDemo_CCES_SHARC_21569\Debug\RTOSLC Check si-revision, Run after load any

2
m

Q
I
]

Restore Defaults...

-

4 L0 3
Filter matched 6 of 8 items { Revert l I Apply l
@ [ Debug I I Close ]

4. Click the Run/Resume button to start running your application
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File Edit Source Refactor Navigate Search Target Project Run Window Help
Y g |n;q5§%a\<bc; Y v Qvmsv[Fovilvoocroy
% Debug = e =
4 d RTOSDemo_CCES_SHARC_21569 Debug [Application with CrossCore Debugger]
« [ ADSP-21569

< # ADSP-21569 [Debug\RTOSDemo_CCES_SHARC_21569.dxe] (Suspended : Breakpoint)
= main(int, char**) at main.c:134 0x1c2288

9.1.5 Test Results

Output from the application should be visible within the Console window in the CrossCore Embedded
Studio IDE. Y ou should see the LEDs on the EZ-Kit begin to flash. Test Passed will be printed if the
all tests passed.

B Console & . ¥ Tasks [l Problems| © Executables AR MBvOv =0
Output
Loading application: "C:\Analog Devices\CrossCore Embedded Studio 2.9.8\SHARC\ldr\ezkit21569_preload.dxe" -

Load complete.

Loading application: "C:\Analog Devices\test_case\freertos-bitbucket\freertos\FreeRTOSv10.0.8\FreeRTOS\Demo\SHARC_ADSP_21569_CCES\RTOSDemo_CCES_SHARC_21569\Debug\RTOSDemo_
Load complete.

Test passed

Test passed

Test passed

Test passed

Test passed

Test passed
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10 Using CrossCore Embedded Studio System Services and
Device Drivers with FreeRTOS

Note: This section of the document applies to the ADSP-SC5xx (Cortex-A and SHARC+) and
ADSPBF7xx processors. It does not apply to the ADUCM* processor families.

CrossCore Embedded Studio provides support for the on-chip peripherals and EZ-KIT hosted device

driversthat are provided for its processors.

In order to use these features with FreeRTOS the source based versions of the drivers must be used
rather than the default pre-built libraries that are provided.

® Use of the library based version of the System Services and Device Driversis not compatible
with FreeRTOS. Use of the pre-built libraries may result in run-time corruption and
execution failure.

To use the System Services and Device Driversin your CrossCore Embedded Studio project:

1. Ensurethat the pre-processor macro __ ADI_FREERTOS is defined for al assembler,C/C++
and linker operations.
This requires the pre-processor macro to defined in three separate locations in the project
settings.

2. Ensure that the pre-built libdrv library is not linked into the application.

a. For Cortex-A projectsthisis controlled by adding the following option to the Settings
>Tool Settings > CrossCore ARM Bare Metal C Linker > Additional Options settings. -
specs=PATH_TO_FREERTOS\FreeRTOS\FreeRTOSv10.0.0
\FreeRT OSSource\portable\ CCES\ARM _CA5\freertos.specs where
PATH_TO_FREERTOS is replaced with the path to the installation of your FreeRTOS
product.

b. For SHARC+ and Blackfin projectsthisis controlled by checking the Settings > Tool
Settings > CrossCore Blackfin/SHARC Linker > Libraries > Omit device driver library
checkbox

3. Enable the source based version of the required services and drivers:
a. Double click the system.svc filein the Project Explorer
b. Click the Add button in the System Configuration Overview

c. Browsethelist of Device Drivers and System Services to add new components to the
project
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4. Build the project

® The provided demo examples for the EZ-KITs contain all the appropriate project settings
already configured and are an easy way to get started with anew FreeRTOS project
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11 Appendix A: FreeRTOS Performance

The following appendix contains code size and performance data for Analog Devices specific ports of
FreeRTOS.

Timer Cycles

The following benchmarks report time and cycle count measurements for post and pending operations
using varying methods of communication.

Benchmark datais available for the following EZ-Kits:
* ADSP-SC589 EZ-Kit (Cortex A5 Core)
* ADSP-SC589 EZ-Kit (SHARC+ Core)
* ADSP-SC573 EZ-Kit (Cortex A5 Core)
* ADSP-21569 EZ-Kit (SHARC Core)
* ADSP-BF707 EZ-Kit
* ADuCM3029 EZ-Kit
* ADuCM4050 EZ-Kit
® Thefollowing projects are executed to gather the benchmark data:

® |SR: calculate Interrupt service time and Timeto return from an ISR when in FreeRTOS
system.

®* FLAG ISR: calculate FLAG Post/Pend available time,context switch time when unavailable,
Interrupt service time and Time to return from an ISR when in FreeRTOS system

* MSG ISR: calculate Message queue Post/Pend available time,context switch time when
unavailable, Interrupt service time and Time to return from an ISR when in FreeRTOS system

* SEM ISR: calculate Semaphore Post/Pend available time,context switch time when
unavailable, Interrupt service time and Time to return from an ISR when in FreeRTOS system

* MUT ISR: calculate Mutex Post/Pend available time,context switch time when unavailable,
Interrupt service time and Time to return from an ISR when in FreeRTOS system

Spaces

The following benchmarks report code size for several common RTOS operations within FreeRTOS.
The benchmark data is available for the following EZ-Kits:

* ADSP-SC589 EZ-Kit (Cortex A5 Core)
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e ADSP-SC589 Ez-Kit (SHARC+ Core)
e ADSP-21569 EZ-Kit (SHARC Core)

ADSP-BF707 EZ-Kit

The following projects are executed to gather the benchmark data:

NONE: Basic project

M essage Queues: Basic project using 1 static object / Basic project using 2 static objects

Flags: Basic project using 1 static object / Basic project using 2 static objects

M utexes. Basic project using 1 static object / Basic project using 2 static objects

Semaphores: Basic project using 1 static object / Basic project using 2 static objects

ALL: Basic project using 1 static object / Basic project using 2 static objects

11.1 ADSP-21569 (SHARC Core) Benchmark Data

ADSP-21569 SHARC Core Performance Metrics

FreeRTOS FLGISR  xEventGroupWaitBits (flag available)

xEventGroupWaitBits (flag unavailable, context switch to new task)

xEventGroupSetBits (no task pending, no context switch)

xEventGroupSetBits (task waiting, context switch to pending task)

xEventGroupSetBits (from an ISR, switching to a pending task)

FreeRTOS ISR Interrupt service time (FreeRTOS)

Time to return from an ISR (FreeRTOS, no task switch)

FreeRTOS MSGISR xQueueReceive(message available)

xQueueReceive(message unavailable, context switch to new task)

xQueueSend(no task pending, no context switch)
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cycles

xQueueSend(task waiting, context switch to pending task) 1434
XxQueueSend(from an ISR, switching to a pending task) 1097
FreeRTOS MUTISR  xSemaphoreTake(mutex available) 238
xSemaphoreT ake(mutex unavailable, context switch to new task 2411
xSemaphoreGive(no task pending, no context switch) 329
xSemaphoreGive(task waiting, context switch to pending task) 1540
FreeRTOS SEMISR  xSemaphoreT ake(semaphore available) 213
xSemaphoreT ake(semaphore unavailable, context switch to new task) 2097
xSemaphoreGive(no task pending, no context switch) 313
xSemaphoreGive(task waiting, context switch to pending task) 1293
xSemaphoreGive (from an ISR, switching to a pending task) 1029

ADSP-21569 SHARC Core Sizing Metrics

Data Code Total

NONE Basic project 59307 29842 89149
Message Queues  Basic project using 1 static object 59403 29970 89373

Basic project using 2 static objects 59483 29970 89453
Flags Basic project using 1 static object 59459 31702 91161

Basic project using 2 static objects 59491 31702 91193
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Data Code Total

Mutexes Basic project using 1 static object 59395 32114 91509
Basic project using 2 static objects 50483 32114 91597
Semaphores Basic project using 1 static object 50395 31982 91377
Basic project using 2 static objects 59483 31982 91465
ALL Basic project using 1 static object 59547 34198 93745

Basic project using 2 static objects 59667 34198 93865

11.2 ADSP-SC589 (Cortex-A Core) Benchmark Data

ADSP-SC589 Cortex-A Core Performance Metrics

cycles
FreeRTOS FLGISR  xEventGroupWaitBits (flag available) 321
xEventGroupWaitBits (flag unavailable, context switch to new task) 1129
xEventGroupSetBits (no task pending, no context switch) 324
XEventGroupSetBits (task waiting, context switch to pending task) 1095
xEventGroupSetBits (from an ISR, switching to a pending task) 3158
FreeRTOS ISR Interrupt service time (FreeRTOS) 109
Timeto return from an ISR (FreeRTOS, no task switch) 24
FreeRTOS MSGISR  xQueueReceive(message available) 287
xQueueReceive(message unavailable, context switch to new task) 2290
xQueueSend(no task pending, no context switch) 309
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cycles

xQueueSend(task waiting, context switch to pending task) 1309
XxQueueSend(from an ISR, switching to a pending task) 648
FreeRTOS MUTISR  xSemaphoreTake(mutex available) 239
xSemaphoreT ake(mutex unavailable, context switch to new task 2630
xSemaphoreGive(no task pending, no context switch) 274
xSemaphoreGive(task waiting, context switch to pending task) 1438
FreeRTOS SEMISR  xSemaphoreT ake(semaphore available) 212
xSemaphoreT ake(semaphore unavailable, context switch to new task) 2442
xSemaphoreGive(no task pending, no context switch) 317
xSemaphoreGive(task waiting, context switch to pending task) 1344
xSemaphoreGive (from an ISR, switching to a pending task) 638

ADSP-SC589 Cortex-A Core Sizing Metrics

Data Code Total

NONE Basic project 97812 18624 116436
Message Queues  Basic project using 1 static object 97812 18680 116492

Basic project using 2 static objects 97812 18680 116492
Flags Basic project using 1 static object 97812 19096 116908

Basic project using 2 static objects 97812 19096 116908
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Data Code Total

Mutexes Basic project using 1 static object 97812 18704 116516
Basic project using 2 static objects 97812 18704 116516
Semaphores Basic project using 1 static object 97812 18664 116476
Basic project using 2 static objects 97812 18664 116476
ALL Basic project using 1 static object 97812 19264 117076

Basic project using 2 static objects 97812 19256 117068

11.3 ADSP-SC589 (SHARC+ Core) Benchmark Data

ADSP-SC589 SHARC+ Core Performance Metrics

cycles
FreeRTOS FLGISR  xEventGroupWaitBits (flag available) 440
xEventGroupWaitBits (flag unavailable, context switch to new task) 1708
xEventGroupSetBits (no task pending, no context switch) 340
xEventGroupSetBits (task waiting, context switch to pending task) 1586
xEventGroupSetBits (from an ISR, switching to a pending task) 4643
FreeRTOS ISR Interrupt service time (FreeRTOS) 236
Timeto return from an ISR (FreeRTOS, no task switch) 182
FreeRTOS MSGISR  xQueueReceive(message available) 409
XxQueueReceive(message unavailable, context switch to new task) 2710
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FreeRTOS_MUTISR

FreeRTOS_SEMISR

xQueueSend(no task pending, no context switch)

xQueueSend(task waiting, context switch to pending task)

xQueueSend(from an ISR, switching to a pending task)

xSemaphoreTake(mutex available)

xSemaphoreTake(mutex unavailable, context switch to new task

xSemaphoreGive(no task pending, no context switch)

xSemaphoreGive(task waiting, context switch to pending task)

xSemaphoreT ake(semaphore available)

xSemaphoreTake(semaphore unavailable, context switch to new task)

xSemaphoreGive(no task pending, no context switch)

xSemaphoreGive(task waiting, context switch to pending task)

xSemaphoreGive (from an ISR, switching to a pending task)

ADSP-SC589 SHARC+ Core Sizing Metrics

Data Code Total

NONE Basic project 50838 29764 89602

Message Queues  Basic project using 1 static object 59934 29896 89830

Basic project using 2 static objects 59934 29896 89830

Flags Basic project using 1 static object 59966 31692 91658
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cycles

476

1877

1160

321

3199

484

2117

275

2711

404

1718

1019
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Data Code Total

Basic project using 2 static objects 59966 31692 91658

Mutexes Basic project using 1 static object 59926 32184 92110

Basic project using 2 static objects 59926 32184 92110

Semaphores Basic project using 1 static object 59926 32048 91974

Basic project using 2 static objects 59926 32048 91974

ALL Basic project using 1 static object 60054 34340 94394

Basic project using 2 static objects 60054 34340 94394

11.4 ADuCM3029 Benchmark Data

ADUCM 3029 Performance Metrics

cycles
FreeRTOS FLGISR  xEventGroupWaitBits (flag available) 258
xEventGroupWaitBits (flag unavailable, context switch to new task) 604
xEventGroupSetBits (no task pending, no context switch) 199
XEventGroupSetBits (task waiting, context switch to pending task) 529
xEventGroupSetBits (from an ISR, switching to a pending task) 942
FreeRTOS ISR Interrupt service time (FreeRTOS) 128
Timeto return from an ISR (FreeRTOS, no task switch) 45
FreeRTOS MSGISR  xQueueReceive (message available) 213
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FreeRTOS_MUTISR

FreeRTOS_SEMISR

cycles

xQueueReceive (message unavailable, context switch to new task) 1043
XxQueueSend (no task pending, no context switch) 243
xQueueSend (task waiting, context switch to pending task) 647
xQueueSend (from an ISR, switching to a pending task) 309
xSemaphoreTake (mutex available) 184
xSemaphoreTake (mutex unavailable, context switch to new task 1252
xSemaphoreGive (no task pending, no context switch) 232
xSemaphoreGive (task waiting, context switch to pending task) 754
xSemaphoreT ake (semaphore avail able) 175
xSemaphoreT ake (semaphore unavailable, context switch to new task) 1068
xSemaphoreGive (no task pending, no context switch) 207
xSemaphoreGive (task waiting, context switch to pending task) 578
xSemaphoreGive (from an ISR, switching to a pending task) 266

ADuUCM 3029 Sizing Metrics

NONE

Message Queues
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Data Code Total

Basic project 4168 7632 11800
Basic project using 1 static object 4172 7692 11864
Basic project using 2 static objects 4244 7692 11936
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Flags

Mutexes

Semaphores

ALL

Data Code Total

Basic project using 1 static object 4124 8136 12260
Basic project using 2 static objects 4152 8136 12288
Basic project using 1 static object 4168 7728 11896
Basic project using 2 static objects 4240 7728 11968
Basic project using 1 static object 4168 7680 11848
Basic project using 2 static objects 4240 7680 11920
Basic project using 1 static object 4272 8320 12592
Basic project using 2 static objects 4444 8320 12764

11.5 ADuCM4050 Benchmark Data

ADuUCM 4050 Performance Metrics

FreeRTOS_FLGISR

FreeRTOS_ISR

FreeRTOS_MSGISR

FreeRTOS User's Guide

xEventGroupWaitBits (flag available)

xEventGroupWaitBits (flag unavailable, context switch to new task)

xEventGroupSetBits (no task pending, no context switch)

xEventGroupSetBits (task waiting, context switch to pending task)

XEventGroupSetBits (from an ISR, switching to a pending task)

Interrupt service time (FreeRTOS)

Time to return from an ISR (FreeRTOS, no task switch)

xQueueReceive (message available)

cycles

259

594

208

532

993

386

157

217
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xQueueReceive (message unavailable, context switch to new task)

XxQueueSend (no task pending, no context switch)

xQueueSend (task waiting, context switch to pending task)

xQueueSend (from an ISR, switching to a pending task)
FreeRTOS MUTISR  xSemaphoreTake (mutex available)

xSemaphoreTake (mutex unavailable, context switch to new task

xSemaphoreGive (no task pending, no context switch)

xSemaphoreGive (task waiting, context switch to pending task)
FreeRTOS _SEMISR  xSemaphoreT ake (semaphore avail able)

xSemaphoreT ake (semaphore unavailable, context switch to new task)

xSemaphoreGive (no task pending, no context switch)

xSemaphoreGive (task waiting, context switch to pending task)

xSemaphoreGive (from an ISR, switching to a pending task)

ADuUCMA4050 Sizing Metrics

Data Code Total

NONE Basic project 4168 8084 12252
Message Queues  Basic project using 1 static object 4172 8144 12316

Basic project using 2 static objects 4244 8144 12388
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193
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234
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165
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Data Code Total

Flags Basic project using 1 static object 4124 8588 12712

Basic project using 2 static objects 4152 8588 12740

Mutexes Basic project using 1 static object 4168 8180 12348

Basic project using 2 static objects 4240 8180 12420

Semaphores Basic project using 1 static object 4168 8132 12300

Basic project using 2 static objects 4240 8132 12372

ALL Basic project using 1 static object 4272 8772 13044

Basic project using 2 static objects 4444 8772 13216

11.6 ADZS-BF707 Benchmark Data

ADZS-BF707 Performance Metrics

FreeRTOS FLGISR  xEventGroupWaitBits (flag available)

xEventGroupWaitBits (flag unavailable, context switch to new task)

xEventGroupSetBits (no task pending, no context switch)

XEventGroupSetBits (task waiting, context switch to pending task)

xEventGroupSetBits (from an ISR, switching to a pending task)

FreeRTOS ISR Interrupt service time (FreeRTOS)

Timeto return from an ISR (FreeRTOS, no task switch)
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cycles

420

1856

356

1866

3158

98

126
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cycles

FreeRTOS MSGISR  xQueueReceive(message available) 47
xQueueReceive(message unavailable, context switch to new task) 2937
xQueueSend(no task pending, no context switch) 630
XQueueSend(task waiting, context switch to pending task) 2412
xQueueSend(from an ISR, switching to a pending task) 1417

FreeRTOS MUTISR  xSemaphoreTake(mutex available) 337
xSemaphoreT ake(mutex unavailable, context switch to new task 3553
xSemaphoreGive(no task pending, no context switch) 663
xSemaphoreGive(task waiting, context switch to pending task) 2624

FreeRTOS SEMISR  xSemaphoreT ake(semaphore available) 271
xSemaphoreT ake(semaphore unavailable, context switch to new task) 2943
xSemaphoreGive(no task pending, no context switch) 504
xSemaphoreGive(task waiting, context switch to pending task) 2093
xSemaphoreGive (from an ISR, switching to a pending task) 1235

ADZS-BF707 Sizing Metrics

Data Code Total

NONE Basic project 6535 13698 20233

Message Queues  Basic project using 1 static object 6623 13762 20385
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Basic project using 2 static objects

Flags Basic project using 1 static object

Basic project using 2 static objects

Mutexes Basic project using 1 static object

Basic project using 2 static objects

Semaphores Basic project using 1 static object

Basic project using 2 static objects

ALL Basic project using 1 static object

Basic project using 2 static objects

FreeRTOS User's Guide

Data Code

6707

6567

6599

6619

6703

6619

6703

6655

6771

13762

14402

14402

14682

14682

14618

14618

15506

15506

Total

20469

20969

21001

21301

21385

21237

21321

22161

22277
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